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CS/CJ Series HOST Link Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

& System Configuration” (page 3)

2 || Selection of External Device

Select a model (series) of the External
Device to be connected and connection
method.

&2 Selection of External Device" (page 13)

<=

3 || Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

&3 Example of Communication Setting"
(page 14)

<=

4 || Communication Settings

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro EX or in offline mode.

Fny Setup Items" (page 84)

<

5 || Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

F7"5 Cable Diagram" (page 89)

<=

Operation
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CS/CJ Series HOST Link Driver

1 System Configuration
The system configuration in the case when the External Device and the Display are connected is shown.
* Communication
Series cpu™ Connection Port SIO Type . Cable Diagram
Settings
CS1G-CPU45 . .
CS1G-CPU44 RS232C port on the RS232C Setting Example 1 | Cable Diagram 1
CS1G-CPU43 CPU unit (page 14) (page 89)
CS1G-CPU42
CS1G-CPU45H ) . )
CS1G-CPU44H Peripheral po*rt on RS232C Setting Example 2 | Cable Diagram 2
CS1G-CPU43H the CPU unit"? (page 17) (page 92)
CS1G-CPU42H
CS1G-CPU45-V1 i )
CS1G-CPU44-V1 CSIW-SCU21 RS232C Setting Example 5 | Cable Diagram 1
CS1G-CPU43-V1 (page 26) (page 89)
CS1G-CPU42-V1
CS1H-CPU67 . .
cs1 CS1H-CPU66 CS1W-SCB21 Rs23pc | Setting Example3 | Cable Diagram 1
CSIH-CPUGS (page 20) (page 89)
CS1H-CPU64
g:iﬁ-ggggiH RS232C Setting Example 3 | Cable Diagram 1
CSIH-CPU66H (page 20) (page 89)
CS1H-CPU65H
CS1H-CPU64H . .
RS422/485 | Setting Example 4 | Cable Diagram 3
CS1H-CPU63H CS1W-SCB41 (dwire) (page 23) (page 96)
CS1H-CPU67-V1
CS1H-CPU66-V1
ggigggggjx% ﬁi:izg)/%s Setting Example 4 | Cable Diagram 4
CSIH-CPUG3-V1 Multilink | (P3€¢23) (page 105)
g:ig'giggzg RS232C port on the RS232C Setting Example Cable Diagram 1
CS1D ) CPU unit 19 (page 70) (page 89)
Duplex CS1D-CPU68HA
Svst CS1D-CPU67HA ) ]
ystem | ~q1p.cPU67P CIIW-CIF11 RS422/485 | Setting Example Cable Diagram 5
CS1D-CPU65P (4wire) 20 (page 73) (page 117)
CJ1G-CPU45 RS232C port on the RS232C Setting Example 1 | Cable Diagram 1
CJ1G-CPU44 CPU unit (page 14) (page 89)
CJIM-CPU23
CJIM-CPU22 Peripheral port on RS232C Setting Example 2 | Cable Diagram 2
CJIM-CPU21 the CPU unit™? (page 17) (page 92)
gﬁﬁ_gigg RS232C Setting Example 5 | Cable Diagram 1
CJ1 CIIM-CPU11 (page 26) (page 89)
CJIH-CPUG66H RS422/485 | Setting Example 6 | Cable Diagram 3
g; }g'gigigﬁ CJIW-SCU41 (4wire) (page 30) (page 96)
gﬁg-gigﬁg 2?;35;485 Setting Example 6 | Cable Diagram 4
CJ1G-CPU42H Multitink | P22°39) (page 105)
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CS/CJ Series HOST Link Driver

Communication

Series cpu™ Connection Port SIO Type . Cable Diagram
Settings
RS232C serial port RS-232C Setting Example Cable Diagram 1
on the CPU unit 11 (page 46) (page 89)
CJ1W-SCU21 RS-232C Setting Example 5 | Cable Diagram 1
CJIW-SCU21-V1 (page 26) (page 89)
i Cable Di 1
CIIW-SCU22 Rs-232c | Setting Example ) fable Diagram
21 (page 76) (page 89)
RS422/485 | Setting Example 6 | Cable Diagram 3
(4wire) (page 30) (page 96)
CJ1IW-SCU31-V1
2?355;485 Setting Example 6 | Cable Diagram 4
Multilink | (P38¢30) (page 105)
RS422/485 | Setting Example Cable Diagram 5
(4wire) 22 (page 80) (page 117)
CJ2H-CPU68-EIP CJIW-SCU32
CJ2H-CPU67-EIP 2%;35;485 Setting Example Cable Diagram 6
CJ2 CJ2H-CPU66-EIP
CJ2H-CPU65-EIP O e (page 120)
CJ2H-CPU64-EIP RS-232C Setting Example 5 | Cable Diagram 1
(page 26) (page 89)
CIW-SCU41 RS4.22/485 Setting Example 6 | Cable Diagram 3
CIIW-SCU41-V1 (4wire) (page 30) (page 96)
ﬁi:ifj)/%s Setting Example 6 | Cable Diagram 4
Multilink | (P28¢30) (page 105)
RS-232C Setting Example Cable Diagram 1
21 (page 76) (page 89)
RS422/485 | Setting Example Cable Diagram 5
CJ1W-SCU42 (4wire) 22 (page 80) (page 117)
2?;35;485 Setting Example Cable Diagram 6
Multilink 22 (page 80) (page 126)
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CS/CJ Series HOST Link Driver

Communication

CP1L-LOODT-A
*3

Series cpu™ Connection Port SIO Type . Cable Diagram
Settings
RS232C serial Port RS-232C Setting Example Cable Diagram 1
on the CPU unit 11 (page 46) (page 89)
CIIW-SCU21-V1 RS-232C Setting Example 5 | Cable Diagram 1
(page 26) (page 89)
g‘];H'gP U28 RS422/485 | Setting Example 6 | Cable Diagram 3
12H-CPU67 4wire age 30 age 96
e CIIW-SCU31-V1 o e e
CJ2H-CPU6S RS4.22/485 Setting Example 6 | Cable Diagram 4
CJ2H-CPU64 (4wire) (page 30) (page 105)
CJ2M-CPU15 Multilink | ‘P?€° page
CJ2M-CPU 14 - -
CI2M-CPU13 RS-232C Setting Example 5 | Cable Diagram 1
CJ2M-CPU12 (page 26) (page 89)
CI2M-CPUII RS422/485 | Setting Example 6 | Cable Diagram 3
CJIW-SCU41-V1 (4wire) (page 30) (page 96)
31452)/485 Setting Example 6 | Cable Diagram 4
CJ2 Multilink (page 30) (page 105)
Setting Example 5 | Cable Diagram 1
CJIW-SCU21-V1 RS-232C (page 26) (page 89)
RS422/485 | Setting Example 6 | Cable Diagram 3
(4wire) (page 30) (page 96)
CJIW-SCU31-V1
RS422/485 . .
CI2M-CPU35 (4wire) Setting Example 6 | Cable Diagram 4
CI2M-CPU34 Multilink | (P28¢30) (page 105)
CI2M-CPU33
CJ2M-CPU32 Setting Example 5 | Cable Diagram 1
RS-232C
CJ2M-CPU31 (page 26) (page 89)
RS422/485 | Setting Example 6 | Cable Diagram 3
CJ1W-SCU41-V1 (4wire) (page 30) (page 96)
RS4.22/485 Setting Example 6 | Cable Diagram 4
(4wire)
Multilink | (P28¢30) (page 105)
CP1L-MOODR-A Option board RS232C Setting Example 7 | Cable Diagram 1
CP1L-MOODR-D CP1W-CIF01 (page 34) (page 89)
CP1L-MOODT-D
CP1L-MOODTI-D RS422/485 | Setting Example 8 | Cable Diagram 5
CP1L-MOCODT-A (4wire) (page 37) (page 117)
CP1 CP1L-LOODR-A
CPIL-LOODR-D Option board
CP]L‘LESDT'D CPIW-CIF11 55355)/485 Setting Example 8 | Cable Diagram 6
CP1L-LOODTI1-D
Multilink | (P38¢37) (page 126)
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CS/CJ Series HOST Link Driver

Communication

Series cpu™ Connection Port SIO Type . Cable Diagram
Settings
Option board RS232C Setting Example 9 | Cable Diagram 1
CP1W-CIF01 (page 40) (page 89)
RS422/485 | Setting Example Cable Diagram 5
(4wire) 10 (page 43) (page 117)
Option board
CPIW-CIF1l RS4.22/485 Setting Example Cable Diagram 6
(‘4wire) 10 (page 43) (page 126)
Multilink pag £
CJ1IW-SCU21 RS232C Setting Example 5 | Cable Diagram 1
CJIW-SCU21-V1 (page 26) (page 89)
i Cable Di 1
CIIW-SCU22 Rs232c | Setting Example avle lagram
19 (page 70) (page 89)
RS422/485 | Setting Example Cable Diagram 5
(4wire) 20 (page 73) (page 117)
CJIW-SCU32
RS4.22/485 Setting Example Cable Diagram 6
(4wire)
CP1H-XOODR-A Multilink 20 (page 73) (page 126)
CP1H-XOODT-D
CP1H-XOODTI1-D RS232C Setting Example 5 | Cable Diagram 1
CP1 CP1H-XAOODR-A (page 26) (page 89)
CP1H-XAOODT-D
CP1H-XAOCODTI-D CIIW-SCU41 RS422/485 | Setting Example 6 | Cable Diagram 3
CPIH-YOODT-D CHIW-SCU41.v1 | (4wire) (page 30) (page 96)
RS4.22/485 Setting Example 6 | Cable Diagram 4
(4wire) (page 30) (page 105)
Multilink | ‘P%® pag
Setting Example Cable Diagram 1
RS232€ 19 (page 70) (page 89)
RS422/485 | Setting Example Cable Diagram 5
CJ1W-SCU42 (4wire) 20 (page 73) (page 117)
RS4.22/485 Setting Example Cable Diagram 6
(4wire) 20 (page 73) (page 126)
Multilink page age
RS422/485 | Setting Example 6 | Cable Diagram 3
(4wire) (page 30) (page 96)
CJ1IW-SCU31-V1
RS4.22/485 Setting Example 6 | Cable Diagram 4
(4wire) (page 30) (page 105)
Multilink | ‘P%® pag
CP1E-NOODR-A
CPIE-NOODT-A
cpg | CPIE-NOODTI-A h:)tftrgiltﬁjgséc Rspzpc | Setting Example | Cable Diagram 1
CP1E-NOODR-D f’mit 12 (page 49) (page 89)

CP1E-NOODT-D
CP1E-NOODT!-D
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CS/CJ Series HOST Link Driver

Communication

Series cpu™ Connection Port SIO Type . Cable Diagram
Settings
Internal RS-232C . .
Setting Example Cable Diagram 9
pofc on the CPU RS232C 14 (page 55) (page 164)
CP2E-ECODO-O | Ut
CP2E-SO0ODO-O
Internal RS-485 RS422/485 | Setting Example Cable Diagram 7
port on the CPU .
. (2wire) 13 (page 52) (page 138)
unit
Setting Example Cable Diagram 1
CP1W-CIFO01 RS232C 15 (page 58) (page 89)
RS422/485 | Setting Example Cable Diagram 5
(4wire) 16 (page 61) (page 117)
CP2E CP1W-CIF11 RS422/485 . .
CPIW-CIFI2-V1 | (4wire) ?ztz“f f’g*l“)“ple (Czbl: ggfram 6
. Multilink pag pag
CP2E-NOODO-O RS422/485 | Setting Example Cable Diagram 8
(2wire) 17 (page 64) (page 151)
Port[ on the RS232C Setting Example Cable Diagram 10
CP2W-CIFD1 15 (page 58) (page 166)
Setting Example Cable Diagram 10
CP2W-CIFD2 RS232C 15 (page 58) (page 166)
Port[ on the RS422/485 | Setting Example Cable Diagram 7
CP2W-CIFD3 (2wire) 18 (page 67) (page 138)

*1 O differs depending on the number of CPU input-output points.
*2  Turn ON the DIP switch 4 on the CPU unit.

*3  10-point CPU units cannot be used.

*4  For RS422/485 (2 wire), set pin No. 2/3 of SW1 to ON.
For RS422/485 (4 wire), set pin No. 2/3 of SW1 to OFF.

NOTE | © When the time of GP4000 series is automatically updated in [Clock Update Settings] of GP-Pro

EX, there are some restrictions as shown below.

For details on [Clock Update Settings], refer to GP-Pro EX Reference Manual.

*CP1L, CP1E and CJ2H does not support automatic update of the time. Specify [Customize] in
[Clock Update Settings].

GP-Pro EX Device/PLC Connection Manual
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CS/CJ Series HOST Link Driver

B Connection Configuration

e 1:1 Connection

e 1:n Connection

* Access beyond network
You can access beyond maximum 3 levels of network.

Max 16 units

N

Network 2 \

Network 1 Network 3

* n:1 Connection (Multilink connection)

Maximum number of connectable units: 16 units
Al

NOTE | ¢ The maximum number of connectable Displays is 16 units. However, keeping performance in
consideration, the number of Displays that can be substantially used is up to 4.

GP-Pro EX Device/PLC Connection Manual 8



CS/CJ Series HOST Link Driver

* n:m Connection (Multilink connection)

Maximum number of connectable units: 16 units
A

~

NOTE | © The maximum number of connectable Displays is 16 units. However, keeping performance in
consideration, the number of Displays that can be substantially used is up to 4.

GP-Pro EX Device/PLC Connection Manual 9



CS/CJ Series HOST Link Driver

m |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Usable port
Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)

coM1™!', comz,
PS-2000B cOM3*L COM4 - -
PS-3450A, PS-3451A, 10 . 1
PS3000-BA, PS3001-8p | COMI, COM2 COM2 CoM2
PS-3650A (T41 model), -
PS-3651A (T41 model) CoMI ) )
PS-3650A (T42 model), *1%) *1%) *]%)
PS-3631A (T42 model) coM1™1"2, com2 COMI COMI
PS-3700A (Pentium®4-M) | COM1*!, cOM2™!, o o
PS-3710A COM3™2 , COM4 COM3 COM3
PS-3711A coM1™!, com2™ com2™ coMm2™
PS4000"3 COM1, COM2 - -

coM1*"2, com2™, 1% 1%
PL3000 COMS3, COM4 COMI COMI
PE-4000B Atom N270 COM1, COM2 - -

COM3™ , COM4™, | cCOM3™, coM4™,

PE-4000B Atom N2600 COMI, COM2 CoMs™ come™ | CoMs™ COME™
PS5000 (Slim Panel Type 4 4 4
Core i3 Model) *> *6 COM1, COM2 COM2 COM2
PS5000 (Slim Panel Type
Atom Model) coM1, com2™7 com2™7 com2™?
*5 %6
PSSOQ% (Enclosed Panel COMI ) )
Type)
PS5000 (Modular Type
PFXPU/PFXPP)"> *6 7 7 o
PS5000 (Modular Type CoMI coMl CoMl
PFXPL2B5-6)
PS5000 (Modular Type *7 *7 *7
PFXPL2BI-4) COM1, COM2 COM2 COM2
PS6000 (Advanced Box) 9 *10 #10
PS6000 (Standard Box) COM1
PS6000 (Basic Box) coM1™ com1™ com1™

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

GP-Pro EX Device/PLC Connection Manual

10




CS/CJ Series HOST Link Driver

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4  Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5  When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the [PC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.

When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6  To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

Settings FAQ ID
PFXZPBMPR42P2, RS422/485 change method FA263858
PFXZPBMPR42P2 termination resistor setting FA263974
PFXZPBMPR44P2, RS422/485 change method FA264087
PFXZPBMPRA44P2 termination resistor setting FA264088

*7  Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8  For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PEXZPSCNM122.

*9  In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch settings (PL3000 / PS3000 Series)

RS-232C
DIP Switch Setting Description
1 OFF"! Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

GP-Pro EX Device/PLC Connection Manual 11



CS/CJ Series HOST Link Driver

RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF"!
- RS (RTS) Auto control mode: Disabled
10 OFF"!

*1  When the connection configuration are the n:1 and n:m connections (both Multilink connections),
turn ON the set value.

RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON

GP-Pro EX Device/PLC Connection Manual 12



2 Selection of External Device

Select the External Device to be connected to the Display.

% Welcome to GP-Pro EX

CS/CJ Series HOST Link Driver

Gr-Prole’

‘_ [] Use System Area

Device/PLC
Mumber of Devices/PLCs 1

Device/PLC1
Manufacturer | OMROM Corporation
Series CS/C) Series HOST Link ~
Fart COm1

Eefer to the manual of this Device/PLC

Eecent Device/PLC

Device Information

Back [B] Communication Settings Mew Logic Cancel

Setup Items

Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer

Select the manufacturer of the External Device to connect. Select "OMRON Corporation".

Series

Select the External Device model (series) and the connection method. Select "CS/CJ Series
HOST Link".

In System configuration, make sure the External Device you are connecting is supported by
"CS/CJ Series HOST Link".

! System Configuration” (page 3)

Port

Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

GP-Pro EX Device/PLC Connection Manual
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3 Example of Communication Setting

CS/CJ Series HOST Link Driver

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are

shown.

3.1 Setting Example 1
B Setting of GP-Pro EX

€ Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLE
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings
S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN
Stop Bit O ®2
Flow Contral (®) HONE ER[DTR/CTS)
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC
Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.
Device-Specific Settings
Allowable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Settings Device
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0 5

GP-Pro EX Device/PLC Connection Manual 14



CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.

GP-Pro EX Device/PLC Connection Manual 15



CS/CJ Series HOST Link Driver

B Setting of External Device

Click the [HOST Link Port] tab from the [PLC Settings] of the ladder software for the communication settings of
the HOST link port (RS232C port on CPU) and set as below.

Setup Items Settings
Speed 19200
Parameter 7,2,E
Mode HOST link
SW1: OFF
DIP Switch”! oo
SW8: OFF
Unit No. Option
Source Network Address 2 Option
Node Address Setting Rotary Switch ™ Option

*1  Use the DIP switch on the front of the unit for setting.

*2  Parameter used when you access beyond network. Set in the routing table of "CX-Net Network Configuration".
Please refer to the manual of the External Device for more details.

*3  Parameter used when you access beyond network. Set with the rotary switch on the front of the Controller Link
unit used for access beyond network.

® Notes

* Do not set the duplicate node address in the same network address group.

GP-Pro EX Device/PLC Connection Manual 16



CS/CJ Series HOST Link Driver

3.2 Setting Example 2
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

GP-Pro EX Device/PLC Connection Manual 17



CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.

GP-Pro EX Device/PLC Connection Manual 18



CS/CJ Series HOST Link Driver

B Setting of External Device

Click the [Peripheral Port] tab from the [PLC Settings] of the ladder software for the communication settings of

the peripheral port and set as below.

Setup Items Settings
Speed 19200
Parameter 7,2,E
Mode HOST link
SW1: OFF
DIP Switch”! O
SW8: OFF
Unit No. Option
Source Network Address 2 Option
Node Address Setting Rotary Switch ™ Option

*1  Use the DIP switch on the front of the unit for setting.

*2  Parameter used when you access beyond network. Set in the routing table of "CX-Net Network Configuration".
Please refer to the manual of the External Device for more details.

*3  Parameter used when you access beyond network. Set with the rotary switch on the front of the Controller Link
unit used for access beyond network.

© Notes

* Do not set the duplicate node address in the same network address group.
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CS/CJ Series HOST Link Driver

3.3 Setting Example 3
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

CS/CJ Series HOST Link Driver

For communication settings of INNER board, open [I/O Table] of the ladder software first. Then, select [INNER
Board Soft Switch] from the menu displayed by right-clicking [CS**-CPU**] (CPU of the External Device to

set) and set as below.

Setup Items Settings
Port settings*1 User settings
Line Speed 19200
Parameter 1,7,2,E
Mode Default (HOST Link)
Send Delay Time 0
CS Control None
Unit No. Option
Source Network Address 2 Option
Node Address Setting Rotary Switch™® Option

*1  [Port settings] can be set only when the ladder software you use is a CX-One.

*2  Parameter used when you access beyond network. Set in the routing table of "CX-Net Network Configuration".

Please refer to the manual of the External Device for more details.

*3  Parameter used when you access beyond network. Set with the rotary switch on the front of the Controller Link

unit used for access beyond network.

@ Notes

* Do not set the duplicate node address in the same network address group.
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3.4 Setting Example 4
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C () RS 422485 2wire] (@) Fi5 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

CS/CJ Series HOST Link Driver

For communication settings of INNER board, open [I/O Table] of the ladder software first. Then, select [INNER
Board Soft Switch] from the menu displayed by right-clicking [CS**-CPU**] (CPU of the External Device to

set) and set as below.

Setup Items Settings
WIRE (2wire/4wire switch)’ 4wire
TERM (Termination resistance switch) 2 ON

Port settings*3

User settings

Line Speed 19200

Parameter 1,7,2,E

Mode Default (HOST Link)
Send Delay Time 0

CS Control None

Unit No. Option

Source Network Address Option

Node Address Setting Rotary Switch ™ Option

*1  Use the WIRE switch on the front of the INNER board to set.
*2  Use the TERM switch on the front of the INNER board to set. For 1:n connection, set only the station that serves

as termination resistance to ON.

*3  [Port settings] can be set only when the ladder software you use is a CX-One.

*4  Parameter used when you access beyond network. Set in the routing table of "CX-Net Network Configuration".
Please refer to the manual of the External Device for more details.

*5  Parameter used when you access beyond network. Set with the rotary switch on the front of the Controller Link

unit used for access beyond network.

 Notes

* Do not set the duplicate node address in the same network address group.
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CS/CJ Series HOST Link Driver

3.5 Setting Example 5
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

GP-Pro EX Device/PLC Connection Manual 26



CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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CS/CJ Series HOST Link Driver

B Setting of External Device

For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting

Setup Items Settings

Unit No. Setting Rotary Switch”! 0

*1  You need to set this switch to the same value as "CPU High Function Unit No." of the serial communication
unit in the I/O table assigned by the ladder tool.

@ Ladder Software Settings
For communication settings of the communication unit, you need to register the serial communication unit to be
used by the ladder software in advance.

After registration, open [I/O Table] of the ladder software. Click [Switch] from the menu displayed by right-

clicking [Serial Communication Unit] and set as below.

Setup Items

Settings

Displayed Parameter

Portl:Host Link Settings*l

Port settings*2

User settings

Serial communication mode Host Link(default)
Data length Tbits

Stop bits 2bits

Parity Even

Baud rate 19200bps

Send delay Default(Oms)
Send delay(user-specified) 0

CTS Control No

1:N/1:1 protocol setting

1:N protocol

Host Link compatible device mode

Default(Mode A)

Host Link unit number

0

*1  When you set the Port2, select "Port2: Host Link Settings".

*2  [Port settings] can be set only when the ladder software you use is a CX-One.
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CS/CJ Series HOST Link Driver

NOTE I » For access beyond network, set as below.

Setup ltems Settings
Source Network Address ! Option
Node Address Setting Rotary Switch 2 Option

*1  Set in the routing table of "CX-Net Network Configuration". Please refer to the
manual of the External Device for more details.

*2  Set with the rotary switch on the front of the Controller Link unit used for access
beyond network.

* Do not set the duplicate node address in the same network address group.
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CS/CJ Series HOST Link Driver

3.6 Setting Example 6
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C () RS 422485 2wire] (@) Fi5 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

CS/CJ Series HOST Link Driver

For External Device communication settings, use the DIP switch of the front of the Serial Communication unit

and ladder software (CX-Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting

Setup Items Settings
Unit No. Setting Rotary Switch”! 0
WIRE (2wire/4wire switch) 4wire
TERM (Termination resistance switch) 2 ON

*1  You need to set this switch to the same value as "CPU High Function Unit No." of the serial communication
unit in the I/O table assigned by the ladder tool.

*2  For 1:n connection, set only the station that serves as termination resistance to ON.

@ Ladder Software Settings

For communication settings of the communication unit, you need to register the serial communication unit to be

used by the ladder software in advance.

After registration, open [I/O Table] of the ladder software. Click [Switch] from the menu displayed by right-

clicking [Serial Communication Unit] and set as below.

Setup Items

Settings

Displayed Parameter

Port1:Host Link Se‘[tings*l

Port settings*2

User settings

Serial communication mode Host Link(default)
Data length 7bits

Stop bits 2bits

Parity Even

Baud rate 19200bps

Send delay Default(Oms)
Send delay(user-specified) 0

CTS Control No

1:N/1:1 protocol setting

1:N protocol

Host Link compatible device mode

Default(Mode A)

Host Link unit number

0

*1  When you set the Port2, select "Port2: Host Link Settings".

*2  [Port settings] can be set only when the ladder software you use is a CX-One.
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CS/CJ Series HOST Link Driver

NOTE I » For access beyond network, set as below.

Setup ltems Settings
Source Network Address ! Option
Node Address Setting Rotary Switch 2 Option

*1  Set in the routing table of "CX-Net Network Configuration". Please refer to the
manual of the External Device for more details.

*2  Set with the rotary switch on the front of the Controller Link unit used for access
beyond network.

* Do not set the duplicate node address in the same network address group.

GP-Pro EX Device/PLC Connection Manual 33



CS/CJ Series HOST Link Driver

3.7 Setting Example 7
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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CS/CJ Series HOST Link Driver

B Setting of External Device
For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.
@ DIP Switch Setting

Dip
Switch

Setting Description

Set whether the user memory is writable or not.
SWi1 OFF ON: Write disable
OFF: Write enable

Set whether data is loaded from a memory cassette or not when the power is on.

SW2 OFF ON: Load enabled
OFF: Load disabled
SW3 OFF Switch the status of special auxiliary relay (A395.12).

Set communication speed of serial port 1.
SW4 OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.
OFF: Accordance with communication setting of ladder software.

Set communication speed of serial port 2.

sws™! OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.
OFF: Accordance with communication setting of ladder software.
SWe'’ OFF | Always OFF.

*1  CPU input-output points are 30 points/40 points only.

@ Ladder Software Setting
1 Start up the ladder software.
2 Select [New] in the [File] menu to display [Change PLC] dialog box.
3 Select External Device in the [Device Type].
4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
5 Select CPU type in the [CPU Type] and click [OK].
6 Select connection type in the [Network Type].
7 Click [OK].
8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.
10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

© Notes

* Do not set the duplicate node address in the same network address group.
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CS/CJ Series HOST Link Driver

3.8 Setting Example 8
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C () RS 422485 2wire] (@) Fi5 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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CS/CJ Series HOST Link Driver

B Setting of External Device
For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.
@ DIP Switch Setting

Dip
Switch

Setting Description

Set whether the user memory is writable or not.
SWi1 OFF ON: Write disable
OFF: Write enable

Set whether data is loaded from a memory cassette or not when the power is on.

SW2 OFF ON: Load enabled
OFF: Load disabled
SW3 OFF Switch the status of special auxiliary relay (A395.12).

Set communication speed of serial port 1.
SwW4 OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.
OFF: Accordance with communication setting of ladder software.

Set communication speed of serial port 2.

sws™! OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.
OFF: Accordance with communication setting of ladder software.
SWe'’ OFF | Always OFF.

*1  CPU input-output points are 30 points/40 points only.

@ Ladder Software Setting
1 Start up the ladder software.
2 Select [New] in the [File] menu to display [Change PLC] dialog box.
3 Select External Device in the [Device Type].
4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
5 Select CPU type in the [CPU Type] and click [OK].
6 Select connection type in the [Network Type].
7 Click [OK].
8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.
10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

© Notes

* Do not set the duplicate node address in the same network address group.
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CS/CJ Series HOST Link Driver

3.9 Setting Example 9
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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CS/CJ Series HOST Link Driver

B Setting of External Device
For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.
@ DIP Switch Setting

Dip
Switch

Setting Description

Set whether the user memory is writable or not.
SWi1 OFF ON: Write disable
OFF: Write enable

Set whether data is loaded from a memory cassette or not when the power is on.

SwW2 OFF ON: Load enabled
OFF: Load disabled
SW3 OFF Not used.
Set communication speed of serial port 1.
SW4 OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.

OFF: Accordance with communication setting of ladder software.

Set communication speed of serial port 2.

SW5 OFF ON: Communication speed of ladder software (Toolbus) is automatically recognized.
OFF: Accordance with communication setting of ladder software.
SW6 OFF Switch the status of special auxiliary relay (A395.12).

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

@ Notes

* Do not set the duplicate node address in the same network address group.
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3.10 Setting Example 10
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C () RS 422485 2wire] (@) Fi5 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B

GP-Pro EX Device/PLC Connection Manual

43



CS/CJ Series HOST Link Driver
|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting
Dip Switch Setting Description

Set whether the user memory is writable or not.
SWi1 OFF ON: Write disable
OFF: Write enable

Set whether data is loaded from a memory cassette or not when the power is on.

Sw2 OFF ON: Load enabled
OFF: Load disabled
SW3 OFF Not used.

Set communication speed of serial port 1.

ON: Communication speed of ladder software (Toolbus) is automatically
recognized.

OFF: Accordance with communication setting of ladder software.

Sw4 OFF

Set communication speed of serial port 2.

ON: Communication speed of ladder software (Toolbus) is automatically
recognized.

OFF: Accordance with communication setting of ladder software.

SW6 OFF Switch the status of special auxiliary relay (A395.12).

SW5s OFF

@ Ladder Software Setting
1 Start up the ladder software.
2 Select [New] in the [File] menu to display [Change PLC] dialog box.
3 Select External Device in the [Device Type].
4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
5 Select CPU type in the [CPU Type] and click [OK].
6 Select connection type in the [Network Type].
7 Click [OK].
8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.
10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

@ Notes
* Do not set the duplicate node address in the same network address group.
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3.1 Setting Example 11
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
Click the [Serial Port] tab from the [PLC Settings] of the ladder software for the communication settings of the
Serial port (RS232C port on CPU) and set as below.

Setup Items Settings
Speed 19200
Parameter 7,2,E
Mode HOST link
SW1: OFF
DIP Switch”! o
SW8: OFF
Unit No. 0

*1  Use the DIP switch on the front of the unit for setting.

NOTE I » For access beyond network, set as below.

Setup ltems Settings
Source Network Address ! Option
Node Address Setting Rotary Switch 2 Option

*1  Set in the routing table of "CX-Net Network Configuration". Please refer to the
manual of the External Device for more details.

*2  Set with the rotary switch on the front of the Controller Link unit used for access
beyond network.

* Do not set the duplicate node address in the same network address group.
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3.12 Setting Example 12
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.

9 Check "Custom" in the [Communications Settings] of the [Internal RS232C port] tab.
10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.
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3.13 Setting Example 13
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C (@) RS 422455 2wire] () RS 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

Click the [Built-in RS-485 Port] tab from the [PLC Settings] of the ladder software for the communication
settings of the Serial port (internal RS-485 Port) and set as below.

Setup Items Settings
Baud 19200
Format 7,2,E
Mode HOST link
Unit No. 0

NOTE I » For access beyond network, set as below.

Setup ltems Settings
Source Network Address ! Option
Node Address Setting Rotary Switch 2 Option

*1  Set in the routing table of "CX-Net Network Configuration". Please refer to the
manual of the External Device for more details.

*2  Set with the rotary switch on the front of the Controller Link unit used for access
beyond network.

* Do not set the duplicate node address in the same network address group.
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3.14 Setting Example 14
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
Click the [Serial Port] tab from the [PLC Settings] of the ladder software for the communication settings of the
Serial port (RS232C port on CPU) and set as below.

Setup Items Settings
Speed 19200
Parameter 7,2,E
Mode HOST link
Unit No. 0

NOTE I » For access beyond network, set as below.

Setup ltems Settings
Source Network Address ! Option
Node Address Setting Rotary Switch 2 Option

*1  Set in the routing table of "CX-Net Network Configuration". Please refer to the
manual of the External Device for more details.

*2  Set with the rotary switch on the front of the Controller Link unit used for access
beyond network.

* Do not set the duplicate node address in the same network address group.
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3.15 Setting Example 15
W Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC
Summary Change Device/FLC
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange
Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~
[rata Length ®7 Os
Parity () HONE (®) EVEN [@a]ul]
Stop Bit O ®2
Flow Contral (®) HONE ER[DTRACTS] () =ONAOFF
Timeout 3 = [zec)
Retry 2 3
Wait To Send 1] = [mz)
Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings

Allowable Mumber Add Device

of Devices/PLCs 16

Add Indirect

Mo, Device Mame Settings Device

& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

& Notes

* Do not set the duplicate node address in the same network address group.
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3.16 Setting Example 16
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C () RS 422485 2wire] (@) Fi5 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting

Dip Switch
CP1W- CP1W- Setting Description
CIF11 CIF12-V1
) ) ON: Insert termination resistance (220€2)
SWi-1 SWi-1 ON OFF: Without termination resistance
ON: RS-422/485 (2wire)
SWi-2 SW1-2 OFF OFF: RS-422/485 (4wire)
ON: RS-422/485 (2wire)
SWi1-3 SW1-3 OFF | OFF: RS-422/485 (4wire)
SW1-4 SW1-4 OFF -
ON: With RS control of RD
SW1-5 SW2-1 ON OFF: Without RS control of RD (always receiving)
ON: With RS control of SD
SWi1-6 SW2-2 ON OFF: Without RS control of SD (always receiving)

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.
13 Reboot the External Device.

@ Notes

* Do not set the duplicate node address in the same network address group.
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3.17 Setting Example 17
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C (@) RS 422455 2wire] () RS 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device

For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-
Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting

Dip Switch
CP1W- CP1W- Setting Description
CIF11 CIF12-V1
) ) ON: Insert termination resistance (220€2)
SWi-1 SWi-1 ON OFF: Without termination resistance
ON: RS-422/485 (2wire)
SWi-2 SW1-2 OFF OFF: RS-422/485 (4wire)
ON: RS-422/485 (2wire)
SWi1-3 SW1-3 OFF | OFF: RS-422/485 (4wire)
SW1-4 SW1-4 OFF -
ON: With RS control of RD
SW1-5 SW2-1 ON OFF: Without RS control of RD (always receiving)
ON: With RS control of SD
SWi1-6 SW2-2 ON OFF: Without RS control of SD (always receiving)

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.
13 Reboot the External Device.

@ Notes

* Do not set the duplicate node address in the same network address group.
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3.18 Setting Example 18
B Setting of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC

Summary

Change Device/PLC

M anufacturer | OMROM Corporation

Series CS/C) Series HOST Link

| Pot [coM1

Text Data Mode Change

Communication Settings

Izolation Unit, please select it to WCC,

Device-Specific Settings

S10 Type () R5232C (@) RS 422455 2wire] () RS 422455 dwire]
Speed 19200 ~

[rata Length @7 Oe8

Parity () HOME (@) EVEN [@a]ul]

Stop Bit O @2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl #WCC Rl WCC

Inthe case of RS232C, pou can select the Sth pin to Al [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
C.

Default

Allowable Mumber Add Device
of Devices/PLCs 16
Mo. Device Mame Settings
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0

Add Indirect
Device

B
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-

Programmer).

Refer to your External Device manual for details.

@ DIP Switch Setting

Dip Switch Setting Description
SWA1 ON ON: Ins§rt terminat.ion 'resistapce (2209) both ends
OFF: Without termination resistance
SW2 OFF -
SW3 OFF -
w4 ON | Orr: Without termimtion resstanee

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select External Device in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type] and click [OK].

6 Select connection type in the [Network Type].

7 Click [OK].

8 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
9 Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10 Set the setup items as below.

Setup Items Setting Value

Baud 19200
Format 7,2,E
Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Transfer the communication settings to External Device.

13 Reboot the External Device.

& Notes

* Do not set the duplicate node address in the same network address group.
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3.19 Setting Example 19
B Setting of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1
Summary Change Device/PLC
[OMRON Corporation Series  [CS/CJ Series HOST Link | Port [com
Text Data Mode Change
Communication Settings
SI0 Type (®) R5232C () RS5422/485(2wire) () R5422/485(4wire)
ool [ETIBEEEEER =
[Diata Length @7 Os
Parity () NONE (®) EVEN (00D
Stop Bit O @2
Flow Control (®) NONE ER(DTRICTS) () XONIXOFF
Timeout 3 seC)
Retry
‘Wit To Send | ms)
RI/WCC [OR:] Jvee
In the case of RS232C, you can select the Sth pin to Rl (Input)
or VCC (5 Power Supply). If you use the Digital's
|zolation Unit, please select it to VCC.
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Name Settings Device
& 1 [pLct | ] [Uinit No.=0.Network=0.Node=0 =
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.

3 Select [CS1D-H] in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5 Select CPU type in the [CPU Type].

6 Select [Work Online] in the [PLC] menu.

7 Click [Yes] in the displayed dialog box.

8 Click [OK] in the displayed dialog box.

9 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.
10 Set the setup items as below.

Setup Items Setting Value

Communications Settings Standard (9600: 1,7,2,E)

Mode Host Link

Unit Number 0

11 Close the [PLC Settings] dialog box.
12 Select [Transfer] -> [To PLC...[PC -> PLC]] in the [PLC] menu to transfer communication settings to the External

Device.

13 Reboot the External Device.

 Notes

* Do not set the duplicate node address in the same network address group.
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3.20 Setting Example 20
B Setting of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1
Summary Change Device/PLC
[OMRON Corporation Series  |CS/CJ Series HOST Link | Port [com
Text Data Mode Change
Communication Settings
SI0 Type (O RS232C () RS5422/485(2wire) (@) RS5422/485(4wire)
Speed 5600 ~
[Diata Length @7 (@)
Parity () NONE (®) EVEN
Stop Bit O1 @2
Flow Control (®) NONE ER(DTRICTS)
Timeout 3 sec)
Retry
‘Wit To Send ms)
RI/WCC Rl VCC
In the case of RS232C, you can select the Sth pin to Rl (Input)
or VCC (5 Power Supply). If you use the Digital's RS232C
Izolation Unit, please select it to VCC.
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Name Settings Device
& 1 [Pt | ] [Unit No.=0.Network=0.Node=0 =
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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For External Device communication settings, use the DIP switch of the External Device and ladder software (CX-

Programmer).

Refer to your External Device manual for details.

4 CP1W-CIF11 DIP Switch Setting

s\iiitih Setting Description

SWIA | ON | G Wthout eminaton esane

SWI2 | OFF | G oS 420485 (e

SWI3 | OFF | G S arnes (e

SW1-4 OFF |-

SWi1-5 ON 811:IF :\X\gti}tlh}zitclé)gtzzlrl(t)ri?z‘ RD (always receiving)
SW1-6 ON 8IljF :V&?hiitﬁgtzzzﬁrilsgf SD (always receiving)

@ Ladder Software Setting

1 Start up the ladder software.

2 Select [New] in the [File] menu to display [Change PLC] dialog box.
3 Select [CS1D-H] in the [Device Type].

4 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
5 Select CPU type in the [CPU Type].

6 Select [Work Online] in the [PLC] menu.
7 Click [Yes] in the displayed dialog box.
8 Click [OK] in the displayed dialog box.
9 Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.

10 Set the setup items as below.

Setup Items

Setting Value

Communications Settings Standard (9600: 1,7,2,E)

Mode

Host Link

Unit Number

0

11 Close the [PLC Settings] dialog box.
12 Select [Transfer] -> [To PLC...[PC -> PLC]] in the [PLC] menu to transfer communication settings to the External

Device.

13 Reboot the External Device.

@ Notes

* Do not set the duplicate node address in the same network address group.

GP-Pro EX Device/PLC Connection Manual 75



CS/CJ Series HOST Link Driver

3.21 Setting Example 21
B Setting of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1
Summary Change Device/PLC
[OMRON Corporation Series  [CS/CJ Series HOST Link | Port [com
Text Data Mode Change
Communication Settings
SI0 Type (®) R5232C () R5422/485(2wire) () R5422/485(4wire)
Speed 115200 ~
[Diata Length @7 (@)
Parity () NONE (®) EVEN (00D
Stop Bit O @2
Flow Contral ER(DTRICTS) (O XONXOFF
Timeout seC)
Retry
‘Wit To Send ms)
RI/WCC [OR:] Jvee
In the case of RS232C, you can select the Sth pin to Rl (Input)
or VCC (5V Power Supply). If you use the Digital's
|zolation Unit, please select it to VCC. Default
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Name Settings Device
& 1 [Pt | ] [Uinit No.=0.Network=0.Node=0 =
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | © Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the DIP switch and rotary switch of the front of the External
Device, the DIP switch of the front of the Serial Communication unit and ladder software (CX-Programmer).

Refer to your External Device manual for details.

1 Turn OFF the External Device.
2 Set the DIP switches on the front of the External Device as follows.

DIP switche Setting
SWi1 OFF
SW2 OFF
SW3 OFF
Sw4 OFF
SW5 OFF
SWé OFF
SW7 OFF
SwW8 OFF

3 Set the rotary switches on the front of the External Device as follows.

Setup Items Setting
Unit No. (Setting Rotary Switch) 0
Node number x 16 (Node Address Setting Switch) 0
Node number x 169 (Node Address Setting Switch) 1

4 Set the DIP switch of the front of the Serial Communication unit as follows.

Setup Items Setting
Unit No. (Setting Rotary Switch) 0

5 Turn ON the External Device.
6 Start up the ladder software.
7 Select [New] in the [File] menu to display [Change PLC] dialog box.
8 set [Device Name] and select [CJ2H] in the [Device Type].
9 click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
10 Select CPU type in the [CPU Type].
11 Select [Work Online] in the [PLC] menu.
12 Click [Yes] in the displayed dialog box.
13 click [OK] in the displayed dialog box.
14 Double click [I/O Table and Unit Setup] in the tree view of the work space.
15 Double click [00 [0000] Empty Slot] in the [[0000] Main Rack] to display the [Select Unit] dialog box.
16 Select serial communication unit in the [Communications Adapter] and click [OK].
17 Set unit number in the displayed [Add Unit] dialog box and click [OK].
18 Double click [I/O Table and Unit Setup] in the tree view of the work space.
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19 Double click the set unit in the [[0000] Main Rack] to display the [View Parameters] dialog box.
20 Set the setup items as below and click [OK].

CS/CJ Series HOST Link Driver

Setup Items

Setting

Displayed Parameter

All parameters, Port1: Host Link Settings or Port2: Host Link

Settings

Port settings User settings
Serial communication mode Host Link(default)
Data length 7bits

Stop bits 2bits

Parity Even

Baud rate 115200bps

Send delay Default(Oms)
Send delay (user-specified) 0

CTS Control No

1:N/1:1 protocol setting

1:N protocol

Host Link compatible device mode

Default(Mode A)

Host Link unit number

0

21 Select [Transfer to PLC] in the [Options] menu and transfer the settings to the PLC.
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3.22 Setting Example 22
B Setting of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1
Summary Change Device/PLC
[OMRON Corporation CS/CJ Series HOST Link | Port [com
Text Data Mode Chanoe
Communication Settings
SI0 Type (O RS232C () R5422/485(2wire) (@) R5422/485(4wire)
Speed 115200
Data Length @7 Os
Parity () NONE (®) EVEN
Stop Bit (@] @2
Flow Control (®) NONE ER(DTRICTS)
Timeout
Retry
‘wait To Send
RI/WCC Rl
In the case of RS232C, you can select the Sth pin to Rl (Input)
or VICC (5V Power Supply). If you use the Digital's RS232C
Izolation Unit, please select it to VCC.
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Name Settings Device
[&] 1 [Pt | ] [Unit No.=0.Network=0.Node=0 =
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|
@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] [ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

NOTE | * Set the unit No. you set in the External Device for "Unit No.".

+ Ifyou do not access beyond network, set "0" for "Network" and "Node" settings.
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B Setting of External Device
For External Device communication settings, use the DIP switch and rotary switch of the front of the External
Device, the DIP switch of the front of the Serial Communication unit and ladder software (CX-Programmer).

Refer to your External Device manual for details.

1 Turn OFF the External Device.
2 Set the DIP switches on the front of the External Device as follows.

DIP switche Setting
SWi1 OFF
SW2 OFF
SW3 OFF
Sw4 OFF
SW5 OFF
SWé OFF
SW7 OFF
SwW8 OFF

3 Set the rotary switches on the front of the External Device as follows.

Setup Items Setting
Unit No. (Setting Rotary Switch) 0
Node number x 16 (Node Address Setting Switch) 0
Node number x 169 (Node Address Setting Switch) 1

4 Set the DIP switch of the front of the Serial Communication unit as follows.

Setup Items Setting
Unit No. (Setting Rotary Switch) 1
WIRE (2wire/4wire switch) 4
TERM (Terminating resistance switch) ON

5 Turn ON the External Device.
6 Start up the ladder software.
7 Select [New] in the [File] menu to display [Change PLC] dialog box.
8 set [Device Name] and select [CJ2H] in the [Device Type].
9 Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.
10 Select CPU type in the [CPU Type].
11 Select [Work Online] in the [PLC] menu.
12 Click [Yes] in the displayed dialog box.
13 Click [OK] in the displayed dialog box.
14 Double click [I/O Table and Unit Setup] in the tree view of the work space.
15 Double click [00 [0000] Empty Slot] in the [[0000] Main Rack] to display the [Select Unit] dialog box.

16 Select serial communication unit in the [Communications Adapter] and click [OK].
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17 Set unit number in the displayed [Add Unit] dialog box and click [OK].
18 Double click [1/O Table and Unit Setup] in the tree view of the work space.
19 Double click the set unit in the [[0000] Main Rack] to display the [View Parameters] dialog box.

20 Set the setup items as below and click [OK].

Setup Items

Setting

Displayed Parameter

All parameters, Port1: Host Link Settings or Port2: Host Link
Settings

Port settings User settings
Serial communication mode Host Link(default)
Data length 7bits

Stop bits 2bits

Parity Even

Baud rate 115200bps

Send delay Default(Oms)
Send delay (user-specified) 0

CTS Control No

1:N/1:1 protocol setting

1:N protocol

Host Link compatible device mode

Default(Mode A)

Host Link unit number

0

21 Select [Transfer to PLC] in the [Options] menu and transfer the settings to the PLC.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

Fng Example of Communication Setting" (page 14)

4.1 Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1

Summary Change Device/FLE
Manufacturer | OMRON Corparation Series  |CS/CJ Series HOST Link | Pot [coM1
Text Data Mode LChange

Communication Settings

S10 Type (®) 52320 () RS 422485 2wire] () RS 422455 dwire]
Speed 19200 ~

[rata Length ®7 Os

Parity () HONE (®) EVEN [@a]ul]

Stop Bit O ®2

Flow Contral (®) HONE ER[DTR/CTS) () HOMA=0FF

Timeout 3 = [zec)

Retry 2 3

Wait To Send 1] = [mz)

Rl /WCC [OR:] (JIwEC

Inthe case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (3% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC.

Default
Device-Specific Settings
Allowable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Settings Device
& 1 [PLCT | ] [Unit No.=0 Metwork=D Node=0 5

Setup Items

Setup Description

SIO Type Select the SIO type to communicate with the External Device.
Speed Select speed between the External Device and the Display.
Data Length Select data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
) Use an integer from 1 to 127 to enter the time (sec) for which the Display waits for the
Timeout .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.

continued to next page
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Setup Items Setup Description
Wait To Send Use an integer fro.m. 0 to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.

Please refer to the manual of the IPC for more detail.

NOTE | * Refer to the GP-Pro EX Reference Manual for Indirect Device.

GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

B Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

& Individual Device Settings

PLC1

Unit Mo, 0 s

Destination Address
Metwark 1]

s

fledd v Default

ak. (0] Cancel

Setup Items Setup Description
Unit No. Enter the unit No. for HOST link.
Network Enter the destination network address.
Node Enter the destination node address.
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4.2 Setup Items in Offline Mode

NOTE | * Refer to the Maintenance/Troubleshooting Guide for information on how to enter offline mode or

about the operation.

Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

* The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device Option

CS/CJ Series HOST Link [GoM1] Page 1/1

510 Type RS2520 B

Speed 19200 =]

Data Length o 7 8

Parity NONE o EVEN 0pD

Stop Bit 1 I

Flow Gontrol J NONE >

Timeout(s) 3w a

Retry 7w | A

Wait To Send(ms) 0w a

; 2005/09/02
| Exit Back 12:47:53
Setup Items Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT |
SIOT To make the communication settings correctly, confirm the serial interface specifications of
ype Display unit for [SIO Type].

We cannot guarantee the operation if a communication type that the serial interface does not

support is specified.

For details concerning the serial interface specifications, refer to the manual for Display unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and reception data.
Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the response from

the External Device.
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Setup ltems Setup Description
Ret In case of no response from the External Device, use an integer from 0 to 255 to enter how many
Y times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving packets to

transmitting next commands.

W Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device].

Cormm, Device Option
C5/CJ Series HOST Link [GOM1] Page 1/1
Device/PLC Name  [PLCI ==
Unit No. [ Iw|al
Network fddress [ f w Al
Node Address [ f w Al
: ZAAn/09/02
et Bagk 12:47:55
Setup Items Setup Description

Select the External Device for device setting. Device name is a title of External Device set

Device/PLC Name with GP-Pro EX.(Initial value [PLC1])

Unit No. Enter the unit No. for HOST link.
Network Enter the destination network address.
Node Enter the destination node address.
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device
you want to set from the displayed list, and touch [Option].

Setup Items Setup Description
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE * GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not
have the [Option] setting in the offline mode.
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5 Cable Diagram

The following cable diagrams may be different from cable diagrams recommended by External Device

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

* The FG pin of the External Device body must be grounded according to your country’s applicable standard.
Refer to your External Device manual for details.

* SG and FG are connected inside the Display. When connecting the External Device to SG, design your system
to avoid short-circuit loops.

* Connect an isolation unit if the communication is not stable due to noise or other factors.

5.1 Cable Diagram 1
Display
Cable Notes
(Connection Port)
GP3000 (COM1) Omron PLC SYSMAC Link Cable (5m) by Pro-face
GP4000"! (COM1) CA3-CBLSYS-01
SP5000"2 (COM1/2) | 1A or
SP-5B00 (COM1) XW2Z-200S-V (2m) or
ST3000 (COM1) XW2Z-500S-V (5m) by OMRON Corporation
ST6000 (COM1)
STM6000 (COMT) ”lf?; c;blleeslsength must be
STC6000 (COM1) ’
ET6000 (COM1)
LT3000 (COM1) 1B User-created cable
IPC™3
PC/AT

GP-4105 (COM1)

GP-4115T (COM1) The cable length must be

GP-4115T3 (coM1) | '€ User-created cable 15m or less.
WE]
i;_éegi—&\géﬁgwﬂ) RJ45 RS-232C Cable (5m) by Pro-face " le length
1D PFXZLMCBRIR21 The cable length must be
(COM1) Sm or less.

*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Except SP-5B00

*3  Only the COM port which can communicate by RS-232C can be used.
® |[PC COM Port (page 10)
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1A)
CA3-CBLSYS-01
or
XW2Z-200S-V External
Displa or ;
4 XW2Z-5008-V I Device )
1B)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
N I e A I
Display 3 |sD(TXD) N 2 | sprxp)
i 1
| P
2 RD(RXD)<—;—X-;—!—> 3 | RD(RXD)
1 H H
7 RS(RTS):I E i : I: 4 | RS(RTS)
] ]
8 |CS(CTS) 't '; ,’ 5 CS(CTS)
1 \ N
5 | SG — 9 | sa
\ “ K
M/ FG

* The cable length must be 15m or less.

1C)

Display side
Terminal block

External Device side

Shield D-sub 9 pin (plug)
e SN Pin | Sene

Display  |SD(TXD) 2 | sp(TxD)

RD(RXD) <—X-—.—> 3 | romxp)

RS(RTS) I_: 4 | RS(RTS)

CS(CTS) :l 5 | cs(cTs)
SG i s | sa
v— 1| re

* The cable length must be 15m or less.
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|

1D)

External Device side
D-sub 9 pin (plug)

: Signal
Pin name

Display

SD(TXD)

2

3 | RD(RXD)
4 | RS(RTS)
5

9

PFXZLMCBRJR21

CS(CTS)
SG
1 FG
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5.2 Cable Diagram 2
Displa
p, v Cable Notes
(Connection Port)
GP3000 (COM1) User-created cable
GP4000"! (COM1) A +
SP5000"% (COM1/2) CS1W-CN225 (2m) or CSIW-CN625 (6m)
SP-5B00 (COM1) by OMRON Corporation
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1) Ele cablle length must be
STC6000 (COM1) User-created cable m or Iess.
ET6000 (COM1) 2B +
LT3000 (COM1) CS1W-CN226 (2m) or CSIW-CN626 (6m)
pPc*3 by OMRON Corporation
PC/AT
User-created cable
2C N
GP-4105 (COMI) CS1W-CN225 (2m) or CSIW-CN625 (6m)
GP-4115T (COM1) by OMRON Corporation The cable length must be
GP-4115T3 (COM1) User-created cable 15m or less.
2D N
CS1W-CN226 (2m) or CSIW-CN626 (6m)
by OMRON Corporation
RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRIJR21
2E +
LT-4*01TM (COM1) CSlW—CI;ZéSN(éng))I\(I)rCCSIW-.CN&S (6m)
LT-Rear Module y orporation The cable length must be
(COMI) RJ45 RS-232C Cable (5m) by Pro-face 11m or less.
PFXZLMCBRIR21
2F +
CS1W-CN226 (2m) or CSIW-CN626 (6m)
by OMRON Corporation

*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Except SP-5B00

*3  Only the COM port which can communicate by RS-232C can be used.
® |[PC COM Port (page 10)
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2A)

D-sub 25 pin (socket)
for Peripheral Port
Connection Cable

Display side
D-sub 9 pin (socket)

Pin_| Sena Pin | Sena
Display 3 | SD(TXD) 2 | SD(TXD)
2 |RD(RXD) 3 | RD(RXD)
7 | RS(RTS) 4 | RS(RTS)
8 |cs(cTs) :—l 5 | cs(cTs) ST CN225
5 SG 7 SG CS1W-CN625
1 FG
) User-created cable >
* The cable length must be 15m or less.
2B)
. . D-sub 9 pin (plug)
panopn ey e Pt
Pin | Send Pin | e
Display 2 | RD(RXD) 2 | RD(RXD)
3 [spxp) 3 [soxo) | (J——=0}
7 |RS(RTS) 7 |RS(RTS) CS1W-CN226
8 |cs(cTs) :I 8 |cs(cTs) CS1WC-)£)N626
5 SG 5 SG

A

\ 4

User-created cable

NOTE | © The cable length must be 15m or less.
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|

2C)
D-sub 25 pin (socket)
Display side for Peripheral Port
Terminal block Connection Cable
Signal : Signal
name Pin | name
Display SD(TXD) 2 | SD(TXD)
RD(RXD) 3 | RD(RXD)
RS(RTS) :_l 4 | RS(RTS)
CS1W-CN225
CS(CTS) 5 CS(CTS) or
sSG 7 SG CS1W-CN625
1 FG
) User-created cable -
NOTE | © The cable length must be 15m or less.
2D)
. ) D-sub 9 pin (plug)
TD'Sp.IayI zlldek for Peripheral Port
erminat bioc Connection Cable
Signal : ignal
name Pin | Same
Display RD(RXD) 2 | RD(RXD)
SD(TXD) 3 [so(rxp) | (J—=@}
RS(RTS) 7 |RS(RTS) CS1W-CN226
or
CS(CTS) :—l 8 |CS(CTS) CS1W-CN626
SG 5 SG
) User-created cable -
NOTE | © The cable length must be 15m or less.
2E)
D-sub 25 pin (socket)
for Peripheral Port
Connection Cable
: Signal
Display RXD Fin name
2 SD(TXD)
3 | RD(RXD) [EZ E|
PFXZLMCBRJR21 4 | RS(RTS) S TNLCND2S
5 | CS(CTS) (')r
7 SG CS1W-CN625
1 FG
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2F)

D-sub 9 pin (plug)
for Peripheral Port
Connection Cable

Signal
name

Display

RXD

RD(RXD)

SD(TXD)

PFXZLMCBRJR21

CS(CTS)

2

3

7 | RS(RTS)
8

5

SG

)

CS1W-CN226
or
CS1W-CN626
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5.3 Cable Diagram 3
Displa
p. v Cable Notes
(Connection Port)
GP3000"! (COM1) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) i + The cable length
GP-Rear Module (COM1) 3A Terminal Block Conversion Adapter by Pro-face g
ST3000™2 (COM2) CA3-ADPTRM-01 must be 500m or
LT3000 (COM1) + less.
PC*3 User-created cable
3B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
3C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
*4 The cable length
GP3000°" (COM2) * must be 500m or
User-created cable less
Online Adapter by Pro-face
CA4-ADPONL-01
3D
+
User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 3E User-created cable must be 500m or
less.
GP4000" (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) PFXZCBADTMI1
SP5000"° (COM1/2) 3F *9
SP-5B00 (COM2) +
ST6000°7 (COM2) User-created cable
STzt Con et
STM6000 (COM1) less
STC6000 (COM1) ’
ET6000" (COM2)
3B ~
PS6000 (Basic Box) User-created cable
(COM1/2)
*10
PE-4009]130 The cable length
PS5000 3G 1 must be 500m or
PS6000 (Optional User-created cable
*10 less.
Interface)

*1 All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

H [PC COM Port (page 10)
*4  All GP3000 models except GP-3200 series and AGP-3302B
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*S  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*6  Except SP-5B00
*7  Except ST-6200

*8  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*9  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.
*10  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
H [PC COM Port (page 10)

[V=lel2ay\\illl ° Please turn ON the termination resistance switch on the PLC.

» Set the 2wire/4wire toggle switch to 4wire.
» Note that pole A and pole B are reversely named for the Display and the External
Device.
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3A)
¢ 1:1 connection
Terminal External Device side
block Shield D-sub 9 pin (plug)
Termination Signal :" l/‘\‘ Pin Signal
resistance name ! [t name
2200 1/4W 4 i N
RDA |« .' .' '. 2 SDB
Display RDB ! I
CA3-ADPCOM-01 | . ! SDA
m — SDA y /A\ 8 RDB
— ' [ N
\ SDB -‘ ——> 6 RDA
\ L
CA3-ADPTRM-01 |TERMRX Mmoo —— Shell FG
SG
FG
User-created cable
¢ 1:n connection
Terminal External Device side External Device side
Terminati block Shield D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
ermination - K A - - T ! A - - T
resistance ?'é’rﬂi' / ,:'I ‘\‘ Pin ﬁ?ﬁi / :’I ‘\‘ Pin ﬁ?ﬁé
2200 1/4W RDA t /\ — 2 SDB f /A\ A 2 SDB
Display CA3-ADPCOM-01 RDB 1 SDA 1 SDA
SDA A 8 RDB A 8 RDB
IE' ANE VAN
SDB T — 6 RDA T — 6 RDA
\ L \ I
CA3-ADPTRM-01 TERMRX N ¥—1 shell FG | S *—— Shell FG
SG
FG

\4

A

User-created cable

NOTE | © When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination

resistance.

* The cable length must be 500m or less.
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3B)

¢ 1:1 connection

Display side

External Device side

Termination D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
i . Signal / N . -
essarce [ pn [ o | /7 7y [(Pn [ Somlname
% 1 RDA f A—— 2 SDB
. 1 H 1
Display 2 RDB 4—'—/: \—J—o—: . 1 SDA
]
3 SDA —A—+—1— 8 RDB
1
7 | sobB —"‘J \—|‘-‘—."—> 6 RDA
1
6 | csB j \g— Shell FG
\, Y
9 ERB
8 CSA j
4 ERA
* 1:n connection
Display side - External Device side External Device side
Termination D-sub 9 pin (socket) Shield D-sub 9 pin (plug) __Shield D-sub 9 pin (plug)
resistance Pin Signal / Ay - - / A - -
2200 1/4W name / [ Pin [ Signal name / [ Pin | Signal name
% 1| RDA |+ /\ . 2 SDB ] /“\ e lE SbB
Display 2 RDB |« 1 !
1 SDA 1 SDA
3 SDA A 8 RDB /A\ 8 RDB
7 | soB —-—/ L 6 RDA 1 6 RDA
6 | CsB j \ \s—] shen| Fa \é—| snhei| Fa
9 ERB
8 CSA j
4 ERA

NOTE | © When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination

resistance.

* The cable length must be 500m or less.
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3C)

¢ 1:1 connection

CS/CJ Series HOST Link Driver

External Device side

o Terminal block Shield D-sub 9 pin (plug)
Termlnatlon Signal / /’\ Pin Signal
resistance name ! A name
1
2200 1/4W RDA |Je—1{ A :: ‘. 2 SDB
' '
Display ,_:_/ \_.'_;_
CA4-ADPONL-01 RDB ; T ! SDA
[]:f — SDA T A——t— 8 RDB
\ ' H
[ \— SDB _‘T—/ T 6 RDA
\ Vi
CA3-ADPTRM-01 |TERMRX Yemmmooooe- ¥—— Shell FG
SG
FG
) User-created cable "
* 1:n connection
) External Device side External Device side
Termination Terminal block Shield D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
i Signal /! AN I Signal /! A% : Signal
RDA + /\ — 2 SDB { /“\ — 2 SDB
DI GA4-ADPONL-01 RDB ! SDA ! SDA
SDA A 8 RDB T A 8 RDB
= AN AR
SDB \‘ — 6 RDA v — 6 RDA
CA3-ADPTRM-01  [TERMRX . ¥—— shel | FG e ¥— Sshell FG
SG
FG

v

A

User-created cable

NOTE | ¢ The cable length must be 500m or less.
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3D)

¢ 1:1 connection

External Device side

Termination  D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
resistance . Signal K AN . Signal
Display 2200 1/4W Pin name / i Pin name
% 2 RDA [« /"\ l.’ 1 2 SDB
] ]
7 RDB [« 1 SDA
3 SDA ' /"\ > 8 RDB
)
CA4-ADPONL-01 8 SDB i : HEEN [N RDA
\ \ 1
\ \ $—] Shel FG
User-created cable
¢ 1:n connection
External Device side External Device side
Termination D-sub 9 pin (plug) Shield D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
resistance Pin Signal / M, Pin Signal ST 7, Pin Signal
Display 2200 1/4W name { i name / i name
1 I} I} A 1
% 2 RDA 1 /A\ [ 2 SDB T /\ [— 2 SDB
7 RDB 1 SDA 1 SDA
A A
3 SDA ' /\ ' ; 8 RDB { /\ ! ; 8 RDB
CA4-ADPONL-01| g SDB v — 6 RDA -\ — 6 RDA
\ [ \ [
emeeeees ¥— shel | FG eeeeeees ¥— shel | FG

\ 4

A

User-created cable

NOTE | ¢ The cable length must be 500m or less.
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*1

rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

3E)
e 1:1 connection
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Termination iignqgl ! FAY Pin | Signal name
resistance*1 / i
RDA [ R 2 SDB
. H ! [}
Display RDB |« /\ 1 SDA
SDA A 8 RDB
SDB _,_/ ‘-l i 6 RDA
CSB j \ \¢g—1 Shell FG
ERB
CSA j
ERA
e 1l:n connection
Display side ) External Device side External Device side
Terminal block Shield D-sub 9 pin (plug) Shield D-sub 9 pin (plug)
Termination Signal / Fay - " v Fad -
resistance*1|__name ! A Pin | Signal name ! FA Pin | Signal name
1 [N [N
1 A [ H A [
Display RDB |« : 1 SDA 1 SDA
SDA : - » 8 RDB At 8 RDB
AN I N AN
SDB “ — RDA ,‘ — 6 RDA
CSB j \ \ g Shell FG ‘\\ ‘.V._' Shell FG
ERB
CSA j
ERA

The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the

NOTE | © The cable length must be 500m or less.
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3F)

¢ 1:1 connection

Terminal External Qevice side
block Shield D-sub 9 pin (plug)
Signal / A : Signal
nagme 'll 'll ‘\‘ Pin name
RDA [¢——F—A—— 2 SDB
] ] [}
RDB 4———?——J/\Lﬁ——f——— 1 SDA
1 1 )
SDA ; /"\ L8 RDB
SDB '-\ '-\ ',' 6 RDA
TERMRX Nt —— Shell FG
SG
FG
User-created cable
External Device side External Device side
Shield D-sub 9 pin (plug) Shield D-sub 9 pin (plug)

A
A
[

v
\
\
\

T

’

A

\

Il
[
]
]
]
T
]

’
[
1
)
]
T

/N

v
\
\

\

T

Termination
resistance
2200 1/4W
Display
.=
\
PFXZCBADTM1
¢ 1:n connection
Terminal
block
Termination - ’
. Signal ’
resistance name !
1 ]
220Q 1/4W% RDA ":
Display RDB
SDA
1
SDB T
\
PFXZCBADTM1 TERMRX \
SG
FG

P | oo

2 SDB

1 SDA

8 RDB

6 RDA
Shell FG

P [ s
2 SDB
1 SDA
8 RDB
6 RDA

Shell FG

v

A

User-created cable

NOTE | © The cable length must be 500m or less.
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3G)

¢ 1:1 connection

Display side External Device side
Termination D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
rzezzigszt?/rlcx Pin Signal ',/' ’/7‘ \“ Pin | Signal name
3 Rx+ e ! A—— 2 SDB
Display % 4 Rx+ ‘_E:J \ P 1 SDA
2 | T SRS S N RDB
™ —J - 6 | ROA
6 NC \ \ p—| sl FG
9 NC
8 NC
7 NC
e l:n connection
Termination D-Sl%%pé?x(:gj‘fket) Shield %ﬁ:g% Ig;végtlauzi)de ___ijliﬂd___ Eéi?flgi?:ifﬁfse
resistance | pin e ','/ ,”A“.‘ Pin_|Signal name| / A Pin | Signal name
| % 3| Rt /\ —| 2 | soB [ /‘\ ™ 2 | sos
Display 4 | Re e 1 SDA 1 SDA
2 Tx+ H A T 8 RDB ' /A\' - 8 RDB
P il e RDA : —— 6 RDA
6 | NC \ “\jl— Shell FG \ \ ] shen FG
9 NC ) ’
8 NC
7 NC

-

resistance.

* The cable length must be 500m or less.

When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination
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5.4 Cable Diagram 4

CS/CJ Series HOST Link Driver

Displayy
(Connection Port)

Cable

Notes

GP3000"! (cOM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

IpC"3

4A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+

User-created cable

4B

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Multi-Link Cable (5m) by Pro-face
CA3-CBLMLT-01
+

User-created cable

4C

User-created cable

The cable length must be
500m or less.

GP3000"! (COM2)

4D

Online Adapter by Pro-face
CA4-ADPONL-01
+

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+

User-created cable

4E

Online Adapter by Pro-face
CA4-ADPONL-01
+
Multi-Link Cable (5m) by Pro-face
CA3-CBLMLT-01
+

User-created cable

4F

Online Adapter by Pro-face
CA4-ADPONL-01
+
User-created cable

The cable length must be
500m or less.

GP-4106 (COM1)
GP-4116T (COM1)

4G

User-created cable

The cable length must be
500m or less.
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Displa
p' vy Cable Notes
(Connection Port)
GP4000™ (COM2) RS-422 Terminal Bllg)rcz)k f(;:):versmn Adapter by
GP-4201T (COM1) -
SP5000™° (COM1/2) 4H pFXZCEf‘DTMl
SP-5B00 (COM2) N
ST6000"° (COM2) U ed cabl
ST-6200 (COM1) ser-created cable The cable length must be
STM6000 (COM1) Multi-Link Cable (5m) by Pro-face 500m or less.
STC6000 (COM1) PFXZCBCBML1
ET6000"7 (COM2) 41 *9
PS6000 (Basic Box) +
(COM1/2) User-created cable
4C User-created cable
PE-4000B"1?
PS500071° The cable length must be
PS6000 (Optional 4 User-created cable 500m or less.
Interface)*10

*1 All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

m |PC COM Port (page 10)
*4  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*5  Except SP-5B00
*6  Except ST-6200

*7  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*8  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 4A.

*9  When using a Multilink Cable (CA3-CBLMLT-01) instead of the Multilink Cable, refer to Cable Diagram 4B.

*10  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
m [PC COM Port (page 10)
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4A)
* n:1 connection
Terminal Terminal External Device side
Termination block ___?b_i‘-?l_d___ block Shield D-Sub 9 pin (plug)
resistance [ gjgnal name K K \‘ Signal name Lo A Pin | Signal name
2200 1/4W ; e : B
£ RDA | 7 \: +—~ RDA [«— — 2 SDB
RDB |¢— i1 RDB |« - 1 SDA
SDA : A —»  SDA : ——»| 8 RDB
s f——/ \—-> SDB : > 6 RDA
SG - — SG Mo » uonﬁector EG
. ) she
TRM CERCEREERE — FG
| " | CA3-ADPTRM-01 | ” | CA3-ADPTRM-01
E] CA3-ADPCOM-01 E] CA3-ADPCOM-01
Display Display
« g

User-created cable

NOTE | © The cable length must be 500m or less.
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4B)
¢ n:1 connection
Terminal Terminal
block block External Device side
M : M3 scre - i
Termination (M3 screw) ....SPJ?LQ..‘ ( v __Shield D-Sub 9 pin (plug)
resistance | Signal name / Y Signal name K ."-l Pin | Signal name
2200 1/4W H A o : C
g RDA |+t — RDA |« T — 2 SDB
RDB 4——/ \—— RDB |e— L 1 SDA
SDA ; A —|  SDA : ——> 8 RDB
spB f—— \—» SDB : | 6 RDA
: v \ ‘®—|Connect
6|t s6 | e 7] Fo
FG CEEPEEERER — FG
CA3-CBLMLT-01 CA3-CBLMLT-01
E] CA3-ADPCOM-01 E] CA3-ADPCOM-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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4C)

n:1 connection

External Device side

Terminal block

Terminal block
(M3 screw)

Display side
D-sub 9 pin (socket)

D-Sub 9 pin (plug)

(M3 screw)

@

€

Slo|l<|o|<

slalalalal@

Slo|la|c|a

=2

&

c g
g

= - 83

o | N ssm.m
o

[}
1S
Sl<|o|<|o
2 o|lo
s|lalalala _
glc|c|o|a|?|"
&
A F
7] u-..m-f.-‘»
Pl PP SEPEOE SN I -- 1l
! '
' '
R m
' '
! !
[ IR SR PRI ISR SO !
Sel o
A —
- <|o|<|m 2
2 ol|lo 2g
lalalala 89
Elc|c|o|o| " B2
& FE
A Fy ml
JEVR I IS SO 2
[y I = Ry o b=
“ oA
i io°
' '
! N N !
] ]

5]
£
mABABGAABBG
z|ala|a|a|lglc|a|c|2|P
sS|lcjc|wn|n w(ojw|o
(2]
.%.123754896m
»
[=
E=R N
£35S
2
a

Signal name|
RDA

feeeed SR U R N ----3

_ _

! !

R |

Y |

St I I T

¥ v H H

[5)

£

fl<|of<|o|gl<|<|o|a

s|dlala|a|@|c|a|c|a|?

Slx|z|o|®|?w|o|u|d

(2]

.%.123754896m
[

Display

+ The cable length must be 500m or less.
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4D)
* n:1 connection
Terminal Terminal External Device side
Termination block ...St‘i.ell‘.j.-.‘ block Shield D-Sub 9 pin (plug)
resistance | Signal name / /% | Signal name r N Pin | Signal name
2200 1/4W ! A o : N
g RDA |« — RDA  [¢— —t 2 SDB
RDB 4——/ .\ —{ RDB |« - 1 SDA
SDA : A —>|  SDA - —» 8 RDB
spB |+ \—-> SDB : R RDA
86— s | ee-e—gge] Fo
TRM CEEPEEERER: — FG
| " | CA3-ADPTRM-01 | " | CA3-ADPTRM-01
—T —T
E] CA4-ADPONL-01 E] CA4-ADPONL-01
Display Display
< g

User-created cable

NOTE | © The cable length must be 500m or less.
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4E)
¢ n:1 connection
Terminal Terminal
block block External Device side
Termination (M3 screw) ___§h_ie_|_d___‘ (M3 screw) __Shield, D-Sub 9 pin (plug)
resistance | gignal name / /| Signal name ! N Pin | Signal name
2200 1/4W ! /\ I ; [
% RDA |« — RDA |+ — 2 SDB
RDB 4——/ " il RDB [« M 1 SDA
SDA : A —|  SDA : ——»| 8 RDB
spB |——/ il spB : > 6 RDA
‘n ‘I ,' “ ot C 1
s6 | se | e i
FG EECECPELPLE *— FG
CA3-CBLMLT-01 CA3-CBLMLT-01
E] CA4-ADPONL-01 E] CA4-ADPONL-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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4F)
* n:1 connection
. Terminal block Terminal block External Device side
D-sub 9 pin (plug) (M3 screw) (M3 screw) D-Sub 9 pin (plug)
Termination . . P e ™ Jemmm————— ~ . ”
resistance Pin |Signal name| A {1 |[Signal name H {\  |Signal name i i Pin |Signal name
2200 1/4W [ [ i i i i
% 2 | RDA |+—H /\\ =1 RDA |e——+—A—+— RDA fe—i" — 2 | spB
7 | RDB | | RDB «a‘—A—/\ . | RoB - R e
. H H [ o ! [
Display 3 | SDA ST\ SDA | ——A—| spA 1 — > & | rDB
[D] 8 | SDB —1 ——>| SDB —-—J \—v—|—> SDB — —— 6 | RDA
| ! L | L |
5 | sG — = se | —+ —— sa | i b e—{eomeee | Fa
] U . I Vil Vi
CA4-ADPONL-01 | _Shell | FG RO = FG LSS $—|_ FG S 1%

D-sub 9 pin (plug)

Pin  [Signal name ,’,r‘.‘ --------- H 7\‘. Signal name

2 | RDA | it a il Iroa
N SR VANEE

Display 3 SDA i E A i E N
[D] 8 | spB —++/ Ml o8

5 | sG - —— so

CA4-ADPONL-01| Shell | FG [V \$—{ FG

NOTE | © The cable length must be 500m or less.
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4G)

* n:1 connection

CS/CJ Series HOST Link Driver

Display side Display side External Device side
Terminal block Terminal block D-Sub 9 pin (plug)
Termination Signal name ;'“. ,"‘. Signal name it i Pin | Signal name
resistance*1 1 1 [ [
% RDA |«— ‘: L I'. RDA  fe—1 — 2 SDB
RDB 4—:4—/ \—H— RDB |« I. : ', 1 SDA
SDA |—+—A—++s SDA || > & | ros
SDB —i—i—/ \—i—ib SDB I: : I: : B 6 RDA
86 |————+1 s6 | i iedomee] v
ERA D 11 | ERA ]
CSA j b i1 | CSA
ERB j i/ | ERB N
CSB g ¥ CSB
Display Display

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

For the Display other than that used as the terminal, set the DIP Switch 1-4 on the rear of the Display to
OFF in the n:1 connection.

NOTE | © The cable length must be 500m or less.
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4H)
¢ n:1 connection

External Device side

Terminal Terminal 4
Termination block Sh|e|d_ block Shield D-Sub 9 pin (plug)
rzezs(;sgga;‘/i‘\e/v Signal name :.' /\ :.' ““ Signal name :""""::'\“ Pin | Signal name
£ RDA | /\ +— RDA [«— — 2 SDB
RDB |e— i 1| RDB [« - 1 SDA
SDA : A —»  SDA : ——»| 8 RDB
sDB _—— \—-> SDB ; | 6 RDA
sG : ! sG Meeoeees * f
-. - Comecir| G
TRM EEEEEERERS — FG
| " | PFXZCBADTMA1 | ” | PFXZCBADTMH1
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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41)
* n:1 connection
Terminal Terminal
block block External Device side
; M3 screw - i
Termination A3 SCrew) ..Shield ( ) _Shield D-Sub 9 pin (plug)
resistance | Signal name / /% | Signal name : N Pin | Signal name
2200 1/4W ; A o : .
g RDA |+t \ — RDA |« ; —t 2 SDB
RDB 4——/ i RDB |e—: A 1 SDA
SDA : A —|  SDA : ——» 8 RDB
spB  |—— \—-—> SDB : L 6 RDA
6|t se | w70 ro
FG EEPEEPPRRR *— FG
PFXZCBCBML1 PFXZCBCBML1
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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4J)

n:1 connection

External Device side

Terminal block
(M3 screw)

Terminal block
(M3 screw)

Display side
D-sub 9 pin (socket)

D-Sub 9 pin (plug)

[}
£
Elo|<|afL|p
c
s|lala|lala
Elo|o|c|z|™
[2)
c s
S|
Elo|~|wo|© mm
o
A A h
e L O =
1 B e R R i ]
' '
' '
' '
' '
' '
' '
' '
[ PR IR S S '
oy o
A A
£
] [m]
ElL x|k |x|Z|0O >
Rl o N NG R
(=)
[2)

Signal name}
Rx+
Rx-

Pin

Termination
resistance
2200 1/4W

Display

Display side
D-sub 9 pin (socket)

[}
£
M+_+_D
= x < O}
mMRUTnNuF
=
(2]
A b
e ¥\ﬁv
[l CEE SR PR R --=""
' '
i i
m 9 m
i i
' '
A IS I S i
S I
[5)
5 o
Sl x|k x|z|elelele|o
nRR_I_IGNNNNF
=y
(2]
Elo|s o]~ |w]|~ W

Display

+ The cable length must be 500m or less.

NOTE
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CS/CJ Series HOST Link Driver

5.5 Cable Diagram 5
Displa
p. v Cable Notes
(Connection Port)
GP3000"! (COM1) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) i + The cable length
GP-Rear Module (COM1) S5A Terminal Block Conversion Adapter by Pro-face g
ST3000°2 (COM2) CA3-ADPTRM-01 must }Ee 500m or
LT3000 (COM1) + less.
PC*3 User-created cable
5B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
5C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
%5 The cable length
GP3000° (COM2) * must be 500m or
User-created cable less. ™4
Online Adapter by Pro-face
CA4-ADPONL-01
5D
+
User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) SE User-created cable must be 5S00m or
less.™
GP4000"® (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) PFXZCBADTMI1
SP5000"7 (COM1/2) 5F *10
SP-5B00 (COM2) +
ST6000°* (COM2) User-created cable
STzt Con e bt
STM6000 (COM1) loss. ™4
STC6000 (COM1) ’
ET6000" (COM2)
5B -
PS6000 (Basic Box) User-created cable
(COM1/2)
11
PE-4009]131 The cable length
PS5000 5G 1 must be 500m or
PS6000 (Optional User-created cable L
*11 less.
Interface)

*1 All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

H [PC COM Port (page 10)
*4  When using CJIW-CIF11, the cable length must be 50 meters or less.
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*5  All GP3000 models except GP-3200 series and AGP-3302B

*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*7  Except SP-5B00

*8  Except ST-6200

*9  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 5A.
*11  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
H |[PC COM Port (page 10)

IYlela/\\illl ° Please turn ON the termination resistance switch on the PLC.

» Set the 2wire/4wire toggle switch to 4wire.
» Note that pole A and pole B are reversely named for the Display and the External
Device.
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5A)

¢ 1:1 connection

¢ 1:n connection

Display

Terminal External Device side
block Shield Terminal block
Termination Signal JTTTTTTTTA Signal
resistance name ,:' ,:' ‘\‘ name
220Q 1/4W RDA |« : A : ll SDB+
Display RDB <—5—/ \—5—5—— ]
CA3-ADPCOM-01 : . SDA
= s I EAR N
— ) )
] \ [ _
\ SDB 1 - RDA-
CA3-ADPTRM-01 [TERMRX Necceeeee »— Fc
SG
FG
User-created cable
Terminal External Device side External Device side
o block Shield Terminal block Shield ~ Terminal block
Termination Signal / fal Signal / ral Signal
resistance name 'l ,/ ‘.| name ':' ,:' ‘-| name
2200 1/4W RDA i /\ — SDB+ : /A\ — SDB+
CA3-ADPCOM-01 RDB SPA- SDA-
A A RDB+
IEI SDA { /\ i RDB+ |l /\II i
SDB ' — RDA- : — RDA-
\ I \ I
CA3-ADPTRM-01 TERMRX | S —— FG | S ¥— FG
SG
FG

A

A 4

User-created cable

NOTE | ¢ When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination

resistance.

* The cable length must be 500m or less.
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5B)

¢ 1:1 connection

Display side External Device side
Termination D-suprinéTgci]c;ITet) , Shield . Ter.minal block
S e W AANS e
Display % 2 RDB :" /\ :" E SDA-
3 | spa :'. A : i RDB+
7 SDB _'.‘__/ \_:l_n:'_. RDA-
6 CSB :I \ ‘\f'— FG
9 ERB
8 CSA ‘:I
4 ERA
* 1:n connection
Tomiain Dibdpn o) Shed  Elemmbeede gy SlenaDacesies
rzeZ%igsltmcvs Pin | Same ,'/ A Signal name ,"I i\ [signal name
1| ROA p——A—t—t s SDB+
Display % RDB |« -: /\" I' SDE : /\-: I:
2 : SDA- . SDA-
3| SDA AT 7’| _RDB* : /\ RDB+
7 SbB —-—"\ ‘\ ',' RDA- ' RDA-
6 CSB j \— FG \— FG
9 ERB
8 CSA ]
4 ERA

NOTE | © When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination

resistance.

* The cable length must be 500m or less.
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5C)

¢ 1:1 connection
External Device side

o Terminal block Shield Terminal block
Tern_1|nat|on Signal / Y Signal
resistance name / AR name
] 1
220Q 1/4W RDA : A :I "| SDB+
! \
Display H / \ HE N
CA4-ADPONL-01 RDB : ] SDA
1
ﬁ — SDA T A———>| RDB+
L \ \ H
[ NI SDB —“—/ “———» RDA-
\ \ Ny
/
CA3-ADPTRM-01 [TERMRX R »— FG
SG
FG
h User-created cable "
e 1l:n connection
) External Device side External Device side
Termination Terminal block Shield Terminal block Shield Terminal block
resistance | Signal / AN Signal ST Signal
2200 1/4W name .’, . 'I' \“ name ", . 'l' \“ name
RDA ] /\ 1 H SDB+ H /\ 1 H SDB+
1
Displa
P CA4-ADPONL-01 RDB SDA- SDA-
SDA T A— RDB+ T A—t RDB+
\ [l ! 1 ! !
H:l]/ SDB v /\ “——>| RDA- [— /\ — RDA-
) N
CA3-ADPTRM-01  [TERMRX | RN > — fG | ¥ FG
SG
FG

\ 4

A

User-created cable

NOTE | ¢ The cable length must be 500m or less.
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5D)

¢ 1:1 connection

External Device side

Termination ~ D-sub 9 pin (plug) Shield Terminal block
resistance Pin Signal / ,7\ Signal
Display 2200 1/4W name ‘,' J ‘\‘ |_name |
% 2 RDA [« /"\ — SDB+
) 1
7 RDB |1 - SDA-
]
3 SDA . A——+—>| RDB+
1
CA4-ADPONL-01 8 sbB  |——/ \—'-‘—,"—v RDA-
\ 1
\ VS Fo

¢ 1l:n connection

\ 4

A

D-sub 9 pin (plug)

User-created cable

External Device side

Shield Terminal block

External Device side

Shield Terminal block

Signal
name

SDB+

SDA-

RDB+

Termination

resistance Pin Signal J AN Signal
Display ~ 220Q 1/4W name ’ :"\‘ | _name |
S B ENAE
7 RDB SDA-
3 SDA i /"\I ! RDB+

\ \
CA4-ADPONL-01 8 SDB .“ '-‘ /: »| ROA-

\
Mmeeneees ~—— fG

RDA-

FG

\4

A

User-created cable

NOTE | ¢ The cable length must be 500m or less.

GP-Pro EX Device/PLC Connection Manual

122
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5E)
¢ 1:1 connection
Display side External Device side
Terminal block Shield Terminal block
Termination iiagr?wgl 7 AN Signal name
. % ] o\
resistance*1 RDA e ',: . :: ". SDB+
. ] ] \
Display g RDB q—l—/: \—l——o—: : SDA-
' | H
] [l N +
e I AN
1 » -
SDB ' —
1
CSB j \\ ‘\,’_ FG
ERB
CSA ‘:I
ERA
¢ 1:n connection
Display side _ External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Termination [~ Signal ; A - s A -
resistance*1|__name ; /A Signal name| /% | Signal name
i [N} [
% RDA A7 SDB+ [— /A\:' | SDB+
i ! P ! i
Display RDB T ] SDA- 5 SDA-
l At 1+ | RDB+ P +
g AN iy R WAV gy
1 ud 1 -
SD8 v | g
vV \“ I\\ II

CSB ‘ FG FG
ERB j ) T '

CSA j
ERA

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

NOTE | © The cable length must be 500m or less.
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5F)

1:1 connection

CS/CJ Series HOST Link Driver

External Device side

Terminal
block Shield Terminal block
Termination Signal / Ay Signal
resistance name 'l 'I \| name
2200 1/4W _ ] A [
Display RDB <—.—/: \—.—.—: : SDA-
1 1 )
[ — SDA ' /‘\ ——*| RDB+
— ) )
| 1 ) ]
— SDB * — > RDA-
\ L
PFXZCBADTM1 TERMRX N »— G
SG
FG
User-created cable
¢ 1:n connection
Terminal External Device side External Device side
block Shield Terminal block Shield Terminal block
Termination - I A - / A -
. S | ’ AN Signal I " Signal
resistance nE’rﬂZ ‘,' ,:' \I nz?me ‘,' ,:' “. ne?me
2200 /4w RDA { a1 SDB+ N SDB+
1 1
Display % RDB /\ SDA- /\ SDA-
SDA A > RDB+ A RDB+
|I=| ! / \ L ; / \ Lo
SDB T — RDA- - — RDA-
\ L \ I
PFXZCBADTM1 TERMRX | S, ¥ — EFG | S, ¥ — FG
SG
FG

v

A

User-created cable

NOTE | © The cable length must be 500m or less.
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5G)
* 1:1 connection
Display side External Device side
Terrpi?ation D-subgpinéisgc:](;lfet) , Shield . T(-:‘Sr.minalil block
resistance Pin P ame i P ignal name
2200 1/4W 3 o e :,,' . ':,’ \l SDB+
Display % 4 Rx+ ‘_,'J \ P SDA-
2 Tx+ :. A—— RDB+
| T _,J ‘-‘ ',‘ RDA-
6 NC \ \s—{ FG
9 NC
8 NC
7 NC
e l:n connection
Tomnaion D bpneonen s YA oney S Do
;";%'St?&"v‘;’ Pin ?gnrlgl ’,'/ /‘IA“.‘ Signal name ',"’ /‘IA\‘.‘ Signal name
. % 3 Rx+ |« :,' A\:' “. SDB+ ': /A\:- "'. SDB+
Display 4 | Re gt SDA- ' SDA-
2 Tx+ A T °|__RDB+ : /‘\ ; RDB+
1 Tx- —-—"\ \—~—'—>“‘ ',' RDA- ".‘ RDA-
6 | NC \»—1 FG \$+—{__FG
9 NC )
8 NC
7 NC

NOTE | © When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination
resistance.

* The cable length must be 500m or less.
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5.6 Cable Diagram 6

CS/CJ Series HOST Link Driver

Displayy
(Connection Port)

Cable

Notes

GP3000"! (cOM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

IpC"3

6A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+

User-created cable

6B

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Multi-Link Cable (5m) by Pro-face
CA3-CBLMLT-01
+

User-created cable

6C

User-created cable

The cable length must be
500m or less.

GP3000"! (COM2)

6D

Online Adapter by Pro-face
CA4-ADPONL-01
+

Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+

User-created cable

6E

Online Adapter by Pro-face
CA4-ADPONL-01
+
Multi-Link Cable (5m) by Pro-face
CA3-CBLMLT-01
+

User-created cable

6F

Online Adapter by Pro-face
CA4-ADPONL-01
+
User-created cable

The cable length must be
500m or less.

GP-4106 (COM1)
GP-4116T (COM1)

6G

User-created cable

The cable length must be
500m or less.
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Displa
p' vy Cable Notes
(Connection Port)
GP4000™ (COM2) RS-422 Terminal Bllg)rcz)k f(;:):versmn Adapter by
GP-4201T (COM1) -
SP5000™° (COM1/2) 6H pFXZCE;ADTMl
SP-5B00 (COM2) N
ST6000"° (COM2) U ed cabl
ST-6200 (COM1) ser-created cable The cable length must be
STM6000 (COM1) Multi-Link Cable (5m) by Pro-face 500m or less.
STC6000 (COM1) PFXZCBCBML1
ET6000"7 (COM2) 61 *9
PS6000 (Basic Box) +
(COM1/2) User-created cable
6C User-created cable
PE-4000B"1?
PS500071° The cable length must be
PS6000 (Optional 6J User-created cable 500m or less.
Interface)*10

*1 All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

m |PC COM Port (page 10)
*4  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*5  Except SP-5B00
*6  Except ST-6200

*7  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*8  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 6A.

*9  When using a Multilink Cable (CA3-CBLMLT-01) instead of the Multilink Cable, refer to Cable Diagram 6B.

*10  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
m [PC COM Port (page 10)
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6A)

¢ n:1 connection

CS/CJ Series HOST Link Driver

External Device side

Terminal Terminal
Termination block .. _?r'_ie_l_d_ . block Shield Terminal block
;e;asg;a:/t;&v Signal name :' /\ :.' \“ Signal name '," ::'\_I Signal name
% RDA RDA |+ SDB+
RDB  [+— / \: i{ RDB |+ — SDA-
SDA A > SDA : | RoB+
SDB —-—/ \—» SDB 4| Roa-
SG —— sc M I
TRM e FG
| " | CA3-ADPTRM-01 | ” | CA3-ADPTRM-01
T —T
@ CA3-ADPCOM-01 @ CA3-ADPCOM-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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6B)
* n:1 connection
Terminal Terminal
block block External Device side
Termination (M3 screw) .- ..Sp.i(.el.d. - (M3 screw) Shield Terminal block
resistance | Signal name J /% | signal name Lo N Signal name
L vy PR W ‘1 RDA |t SDB+
RDB 4——/ \—— RDB  |¢—: SDA-
SDA |— /\ NI : ] RDBe
SDB : / \—-—> SDB i, RDA-
SG : 1 sa L o rc
FG S =
CA3-CBLMLT-01 CA3-CBLMLT-01
@ CA3-ADPCOM-01 @ CA3-ADPCOM-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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6C)

n:1 connection

External Device side
(M3 screw) Terminal block

Terminal block

Terminal block
(M3 screw)

Display side
D-sub 9 pin (socket)

[}
£
& + ' + B
clo|<|o|<
s|la|Q|la|a m
S|ln|lv|xe|x
2
A 4 h
B =)
PR U N AN, “
|
|
|
|
1
RV IR S S |
=4

[5]
g
gl<|la|<|alop|lo
—l1alalala B —
Ele|lz|a|la|?|™
=
y A b
Seul N e
[ el it s i 1
S gy m
N Y m
T T
r v .
El| ol < g
s @ alolo 08
“l1alalala 3
Sle|le|o|a|?|™ e
2 2s
3 A ag
......... [ o
R e s R S 1 0%
' : 7
fa
R m
! N N !
' '
[ F-=q==-f- - ==1-"-"=—======——o___
[5] 4 A
g
SI<|o|<|m < |<|m|m
s|alala|a||z|a|z|a|?
Slr|e|o|o|?w|d|u|ld
(2]
El-|N|o|~|w|t|o|lo|o© 2
»

Termination
resistance

2200 1/4W

Display

[5]
£
g <ol |o|lop|lo
= a
1EHEIBHE
g
r'y h
S g I Ly
VT T H
D m
m NG m
kT
Yy v H H
[5)
£
S << (@ < |<|m|m
s|Sla|a|la|@lz|a|z|a|@
sle|le|o|n w|o|w|o
o0
%123754896@
%]

Display

+ The cable length must be 500m or less.

NOTE
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6D)
¢ n:1 connection
Termination
resistance
220Q 1/4W

CS/CJ Series HOST Link Driver

Terminal Terminal External Device side
block ‘__S_bi_(_;._@_"‘ block Shield Terminal block
Signal name :' /| Signal name ':’""'"..".‘ Signal name
roA i\ 1 RDA et - SDB+
RDB 4—‘—/ \—— RDB  |+—i : SDA-
son A\ ] spa +— [ RroB+
SDB g \—-—> SDB i 5[ roA-
SG SG Neeeaes o—I o
TRM R
| ” | CA3-ADPTRM-01 | " | CA3-ADPTRM-01
— —T
E] CA4-ADPONL-01 E] CA4-ADPONL-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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6E)
* n:1 connection
Terminal Terminal
block block External Device side
Termination (M3 screw) ___§_h_ie_>|_d___‘ (M3 screw) __Shield Terminal block
rzezs(;gasflv Signal name :.' /\ :.' “‘ Signal name :' ."n“. Signal name
g RDA |+ —— RDA [+ :": SDB+
RDB 4—/ \—— RDB |« — SDA-
Y AV N gy : +——»| RDB+
SDB 4 \—-> SDB : H »| RDA-
SG . LA e s o1 ro
FG SR A
CA3-CBLMLT-01 CA3-CBLMLT-01
E] CA4-ADPONL-01 E] CA4-ADPONL-01
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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CS/CJ Series HOST Link Driver
|

6F)
* n:1 connection
) Terminal block Terminal block External Device side
D-sub 9 pin (plug) (M3 screw) (M3 screw) Terminal block
Termination , _ pommmmmmoos N[ ] i n ittt k)
resistance | Pin  [Signal namej [ I\ |Signal name H /\  |Signal name i i\ |Signal name
2200 1/4W [ [ i . i i
2 | RDA — /\\,' — RDA fe— /\\: +— RDA . —— SDB+
P P i P B P
7 | RDB |+—— — RDB |e—— i+ | RDB |e—i— —— SDA-
Display 3 | SDA : /\\ —> SDA ! /\ L—» SDA : ——> RDB+
[D] 8 | sbB ; — sDB . \—tl—l:'rsos — ——* RDA-
5 | sc — = so — H— sc i+ ro
CA4-ADPONL-01 | Shell | FG  j——e-----mmo- = FG [V $w— FoG VA 1Y
D-sub 9 pin (plug)
Pin  |signal name ,‘":. --------- ,’T\‘. Signal name
I A
2 RDA |« : //\\; : RDA
7 | RDB |e—i— 4 RDB
Display 3 | spA | //\\i > SDA
[D] 8 | sbB i —» sDB
5 SG — — sG
CA4-ADPONL-01| Shell | FG Y $— FG

NOTE | © The cable length must be 500m or less.
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6G)

* n:1 connection

CS/CJ Series HOST Link Driver

Display side Display side External Device side
Terminal block Terminal block Terminal block
e s B e B L
% RDA |« A RDA:I:": SDB+
— RDB  |«——~ : ——— : RDB |« :' :I :' :. SDA-
SDA A SDA ! ; RDB+
SDB —~/ \—~—> SDB | s RoA-
s |+ 56 ] i i w
ERA D D ERA Vi ¥
CSA ] L i | csA ] ’
ERB [ || L1 | ERB
CSB ] 1 [ _csB ]
. i
Display Display
*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

For the Display other than that used as the terminal, set the DIP Switch 1-4 on the rear of the Display to

OFF in the n:1 connection.

NOTE | © The cable length must be 500m or less.
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CS/CJ Series HOST Link Driver

6H)
¢ n:1 connection
Terminal Terminal External Device side
Termination block .. _§[1_|e_|_d_ . block Shield Terminal block
resistance [ sjgnal name / /| Signal name Lo A Signal name
220Q 1/4W N HEEY ' R
£ RDA  fe— /\ + RDA [«— — SDB+
RDB [|¢— i1 RDB [« - SDA-
SDA : A —»| SDA : —»| RDB+
spB  ——!/ \-—-> SDB - i+ RDA-
SG -“ -“ ': SG Semmmmaa o— EFG
TRM EEREEREERS o— FG
| " | PFXZCBADTMH1 | ” | PFXZCBADTMH1
— —T
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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6l)

n:1 connection

Termination
resistance
2200 1/4W

CS/CJ Series HOST Link Driver

Terminal Terminal
block block External Device side
(M3 screw) ____S_h_ii_il_d___‘ (M3 screw) Shield Terminal block
Signal name ..' ..' ' Signal name ,'"""": ‘-‘ Signal name
RoA Je—i— N\ ‘1 RDA |e—ri — SDB+
RDB 4——/ \—— RDB _[+—i P SDA-
sbA |— A [ spA : SN =
SDB g \—-—> SDB : [ RDA-
SG "‘ "‘ SG Seeeees 1 fo
FG '— FG
PFXZCBCBML1 PFXZCBCBML1
Display Display
< >

User-created cable

NOTE | © The cable length must be 500m or less.
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CS/CJ Series HOST Link Driver

6J)

n:1 connection

Terminal block External Device side
Terminal block

(M3 screw)

Terminal block
(M3 screw)

Display side
D-sub 9 pin (socket)

Signal name
SDB+
SDA-
RDB+

Sl N A O 2
A
g
Sl+|ol+ o |O
< < < [©) - »
sE|EE|F|E|x
2
(2]
; |
< Tl
VT
' '
| A\ A\ |
A N AN “
koo I N
m + o |+ [m] m
Slxx(k|x|=z|O 38
S @& |- |- |G|T 22
3 >c
'y L3
........ O oo
[ R A O ittt [aps
! P
ard °
'
! NN
'
lemmmf==q===~"" i ittt b T PP, .H
[}
5 o
El+| o+
s | x| x| x| x[=zQ
W ¥|E|~|[F|G|Z
(2
C
T M| N |~ |O| M~
m%mz%
55
€28
88

Display

Signal name|

[

£

S|+ [
EERENEEBEEEEE
5| = [0)

»

c ]

Display

+ The cable length must be 500m or less.

NOTE
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5.7 Cable Diagram 7
Displa
p, v Cable Notes
(Connection Port)
GP3000"! (COMI) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) . +
GP-Rear Module TA Terminal Block Conversion Adapter by Pro-face The cable length
(COM1) CA3-ADPTRM-01 must be 500m or
ST3000°2 (COM2) + less.
LT3000 (COM]) User-created cable
7B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
7C Terminal Block Conversion Adapter by Pro-face
t be 500
User-created cable s 1e mor
ess.
Online Adapter by Pro-face
CA4-ADPONL-01
7D
+
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 7E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be S00m or
+ less.
User-created cable
7F User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 7G User-created cable must be 500m or
less.
GP-4107 (COM1)
GP-4*03T"S (COM2) The cable length
GP-4203T (COM1) TH User-created cable must be 500m or
less.
GP4000"® (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) PFXZCBADTMI
SP5000™7 (COM1/2) 71 *10
SP-5B00 (COM2) +
ST6000*8 (COM2) User-created cable The cable length
ST-6200 (COM1) must be 500m or
STM6000 (COM1) less.
STC6000 (COM1)
ET6000™° (COM2) 7B User-created cable
PS6000 (Basic Box)
(COM1/2)
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CS/CJ Series HOST Link Driver

Displa
p. Y Cable Notes

(Connection Port)

N ko
Ei—iegiidl\g éﬁng) RJ45 RS-485 Cable (5m) by Pro-face The cable length
(COMI) 7 PFXZLMCBRIJRS81 must be 500m or

less.

oo The cable length
PS5000"!! e cable leng
PS6000 (Optional 7K User-created cable must ble 500m or
Interface)*1 1 ess.

*1  All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

m |[PC COM Port (page 10)
*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*7  Except SP-5B00
*8  Except ST-6200

*9  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 7A.
*11  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
m |[PC COM Port (page 10)
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7A)
e 1:1 connection
Display side
Terminal block Shield
mmmmmm———— A
. . . ! Y
rT:Sr?;tlgs(t:lgn Signal name / ! \ External Device side
1 ] \ H
220Q RDA [« {1 Terminal block
' ]
Displa . ignal
P8y CA3-ADPCOM-01 RDB At Signal name
=y R VAEEC
| 1
NI SDB ) » A(-)
CA3-ADPTRM-01 SG N d——  FG
FG
User-created cable
e 1l:n connection
Display side
Terminal block
Terminati . Shield Shield
r:;{;'gﬁc'g" Signal name ,'"""""7’\‘ External Device side /""" """~~~ ’7‘ , External Device side
2200 RDA f / \ Terminal block ¢\ Terminal block
/ b ] [
Display .2 xopcom.ot RDB : /\;' ‘: Signalname | | A Lo Signal name
] 1
= I B VAV I VAN
\ i \
- SDB T v 7 A(-) + — A(-)
\ \ ! 1 \\ 1
CA3-ADPTRM-01 SG R, »—— FG | S, v—— FG
FG

v

F 3

User-created cable
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CS/CJ Series HOST Link Driver

7B)
e 1:1 connection
Display side
D-sub 9 pin (socket) Shield
smmmmmm———— “A
Termination ; ; / A
resistance Pin _| Signalname :'I /I “. External Device side
2200% 1 RDA [+ { '} Terminal block
. )
Display 2 RDB /\.: li Signal name
3 SDA : / \’, +— B(+)
1 \ 1
7 SDB : — A(-)
\ v
5 SG |, ¥— FG
4 ERA :l
8 CSA
9 ERB
6 CSB :l
Shell FG
e l:n connection
Display side
D-sub 9 pin (socket) Shield
Termination Pin Signal name II, ---------- ?‘\ Shield
resistance 9 H ! \External Device side,;/” """~ ; 7\ External Device side
2200% 1 RDA " ':' ‘.| Terminal block ‘:' ,I\‘ Terminal block
. ] ] ! 1
Display 2 RDB ¢ /\é li Signal name :.' /\ :: ‘: Signal name
] ]
3 SDA ‘ / \". : B(+) :/ \:| i B(+)
1
7 SDB “ —— A() e i A()
\ \
5 SG e FG Mol v | rc
4 ERA :l
8 CSA
9 ERB
6 CSB :l
Shell FG
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70)
¢ 1:1 connection
Display side
Terminal block
o ; Shield
T tion | Signalname | — ,-=-=e=cem-- ” . .
r:srirztlgsclgn Signal name / AN External_ Device side
2200 RDA ? ',' ‘\‘ Terminal block
]
Displa : P ignal
D CA4-ADPONL-01 RDB [ A Signal name
]
m — SDA '.' / \'| i B(+)
N — DB 0 — A(-
y s v 0
CA3-ADPTRM-01 SG \ e FG
FG
User-created cable
¢ 1l:n connection
Display side
Terminal block
— ) Shield Shield
;r:sri':t'gsggn Signal name ST /’, “\\Ext$rnal_Delz\g:;e Eide'/ """" ’7‘ \ Ext_lt?rnal_ D(T\glce Eide
1
' 2200 RDA :, :, “. erminal blocl :: ", .“ erminal blocl
Display CA4-ADPONL-01 RDB /\ ! ‘: Signal name :' /\ ! ': Signal name
- N ! P
__ SDA — B(+ : - B(+
= A VI - A Y
NE—-— SDB v — A(-) ; — A)
\ 1 [} \\ 1
CA3-ADPTRM-01 SG ‘.---------.“.’_ FG N v—| FG
FG

F 3

v

User-created cable
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CS/CJ Series HOST Link Driver

7D)
e 1:1 connection
Display side
D-sub 9 pin (plug)
— ) . Shield
Termination | Pin |Signalname| — ---Zo-lo--- » ’ :
resistance . :’, / \ External_ Device side
2200% RDA 7 [ Terminal block
. ]
Display 7 RDB [« ': /\;' =: Signal name
3 SDA (—+ P B(+)
VAV
8 SDB T '.\ ,' > A(-)
\
CA4-ADPONL-01 | 5 SG \ i FG
Shell FG
User-created cable
e 1l:n connection
Display side
D-sub 9 pin (plug)
Termination | Pin | Signal name ’--_S_hl.e.k.i___" Shield
resistance K /™, External Device side/™" """~ 7\ External Device side
2200 % 2 RDA 1 { \ Terminal block 'l‘.‘ Terminal block
]
Display 7 RDB : :" :: Signal name :" /\ :' ": Signal name
! ! HE
3 | spA 1= 7 \:: B(+) ‘./ T B(+)
8 SDB - — A(-) - i A()
CA4-ADPONL-01 [ 5 SG A w | Fc LN v FG
Shell FG

v

A

User-created cable
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7E)
¢ 1:1 connection

CS/CJ Series HOST Link Driver

External Device side

Display side
Terminal block Shield Terminal block
FESSSSsssss ey
Termination | Signal name ! i Y Signal name
resistance H /\ N
2200 RDA ' / \. H B(+)
] ]
Displa — — -
pay CA3-ADPCOM-01 RDB \ v AC)
[]:( — SDA \ e FG
[ — SDB
CA3-ADPTRM-01 SG
FG
User-created cable
¢ 1:n connection
Display side ) External Device side ] External Device side
Terminal block __E[\lejg__ Terminal block _.S.flllj'_d" Terminal block
Termination | Signal name ," ! ‘\ Signal name / A Signal name
resistance / /\ .'l \ ! /\ ! "-
2200 RDA v / \: B(+) / \ : B(+)
. ] (] 1
Display a3 ApPCOM-01 RDB \ 1 AC) \ \ ) AC)
[]:f — SDA (S, »—1 FG Necooeee — FG
[ — SDB
CA3-ADPTRM-01 SG
FG
User-created cable
144
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7F)
e 1:1 connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
Termination | Pin | Signal name ,’I’“““-“:’?\\ Signal name
resistance H /\ [
2200 1 | DATA+ |« — B(+)
Display % 2 | pata- :\ / \‘ — AQ)
3 NC . o’ FG
7 NC
5 |SG(GND)
4 ERA
8 CSA :l
9 ERB
6 CSB :l
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) ’__f?i(‘:'f‘__\ Terminal block ’__S_fliﬂd__h Terminal block
;':;if:tigiggn Pin | Signal name 'l,’l /\ :," ‘\‘. Signal name ",'l /\ :," ‘\‘. Signal name
2200 1 | DATA+ |e L B(+) : — B(+)
Display % 2 | DATA- “\ / \‘ s A) / \',' AC)
3 NC \ ‘o’ FG Mo w1 Fc
7 NC
5 |SG(GND)
4 ERA
8 CSA j
9 ERB
6 CSB :l
Shell FG
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7G)

*1

Terminal block Shield Terminal block
RPN »
Termination Signal name l,’l '," ‘\ Signal name
resistance *1 RDA ! /\ A B(+)
] H 'I
! ]
Display RDB e+ / \I. 'E > A(-)
)
SDA L e—] Fo
[
SDB —x—_ N/
SG
ERA :l
CSA
ERB
css o
¢ 1:n connection
Display side ) External Device side ) External Device side
Terminal block Shield Terminal block Shield Terminal block
. ST AN K ’ --------1 \ .
inati Signal name ! ! | ! P |
Ter.r”t'”at'orl1 ig ;, /\ ", \‘ Signal name ‘,, /\ :, “. Signal name
resistance RDA [« / \' ". > B(+) ./ \' ¢ B(+)
. ! ] ] 1 !
Display % RDB [« —— A() ¥ — A()
' ]
sbA L e—1 FG Moeeee w1 Ffo
vV
sbB ——_ N/
SG
ERA :l
CSA
ERB
css T

1:1 connection

Display side

External Device side

The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the

rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

GP-Pro EX Device/PLC Connection Manual
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CS/CJ Series HOST Link Driver

7H)
¢ 1:1 connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
Termination [ Pin | Signal name ,’I’“““-“:’?\\ Signal name
resistance H /\ P
2200 3 LINE+ |t — B(+)
Display % 8 | LINE- 4‘\ / \‘ s AQ)
5 |scGND)| ‘o’ FG
1 NC
2 NC
4 |RS(RTS)
6 5V
7 NC
9 NC
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
Termination | Pin | Signal name ,’I’“““-“?\\ Signal name ,'/ ------- ,'-lh‘\ Signal name
resistance :' /\ P ! /\ oA
2200 3 | LINE+ |« — B(+) ’ — B(+)
Display % 8 LINE- J\ / \:\ I." > AC) “/ \“f A-)
5 |seGND)| ‘o FG Noeeee M1 FG
1 NC
2 NC
4 |RS(RTS)
6 5V
7 NC
9 NC
Shell FG

GP-Pro EX Device/PLC Connection Manual 147
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70)
¢ 1:1 connection
Display side
Terminal block
- . Shield
rT:Sng?ggn Signal name I,'""""'",,’\\ Externall Device side
2209% RDA [« [ Terminal block
1
Display RDB :" /\:' =: Signal name
(]
___ SDA |— —— B(+)
[ 1 SDB ! / \t' : A(-)
\\— “ I\ I,'
PFXZCBADTM1 SG \ ‘\;’ FG
FG
User-created cable
¢ 1l:n connection
Display side
Terminal block
- ) Shield Shield
;Eé?;:;sggn Signal name ,'""""'",,’\ External Device side/"""" """~ 17\ External Device side
2200 RDA 2 !\ Terminal block | ¢\ Terminal block
. % ; iy i i
Display RDB ~': /\; ': Signal name :‘ /\ i ': Signal name
1 ! 1 1 [
— SDA 4 / \: + B(+) ¢ o B(+)
[ | \ \ 1 | [
R \ N ' \ [
\m— sbB_|— A vl s
PFXZCBADTM1| SG \ v FG \cmmmmmen — | FG
FG

User-created cable
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CS/CJ Series HOST Link Driver

)

¢ 1:1 connection

External Device side
Terminal block

Display Signal name
D1 B
(+)
D
@:'.< 0 AC)
(1) GND FG
¢ 1:n connection
External Device side ) External Device side
Terminal block __S_fllfl_d__ Terminal block
Display Signal name ," /\ ,'l ‘\‘ Signal name
D1 1 1
o B(+) |¢ o B+
]
D A(-) <—|—",‘ ‘—\—-—> A(-)
(1) FG Ncmmeem o——— FG
Number Name Notes

RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRIRS1
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7K)

¢ 1:1 connection

Display side External Device side
D-sub 9 pin (socket) __f?ii'?__ Terminal block
::;ir;iziggn Pin [ Signal name 'l,’l /\ :,’7\““' Signal name
2200 2 | DATA+ |« — B(+)
Display % 1 | paTA- 4‘\ / \‘ — AQ)
3 NC . o FG
7 NC
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) __E?i_e_@__ Terminal block ’__S_Qifld__h Terminal block
Esrinsﬁg:ggn Pin | Signal name ’,’ /\ ',’7\‘\‘ Signal name ,,'l /\ ','l ‘\‘ Signal name
2200 2 | DATA+ |t — B(+) : — B(+)
Display % 1 DATA- ~:‘ / \:‘ ,': > A(-) <—:|‘—/ \—:\‘—;—v A(-)
3 NG | o’ FG Moeeee w1 Fo
7 NC
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
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CS/CJ Series HOST Link Driver

5.8 Cable Diagram 8
Displa
p, v Cable Notes
(Connection Port)
GP3000"! (COMI) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) . +
GP-Rear Module 8A Terminal Block Conversion Adapter by Pro-face The cable length
(COMl) CA3-ADPTRM-01 must be 500m or
ST3000"2 (COM2) * less.
LT3000 (COM]) User-created cable
8B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
8C Terminal Block Conversion Adapter by Pro-face
must be 500m or
User-created cable |
ess.
Online Adapter by Pro-face
’D CA4-ADPONL-01
+
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 8E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be S00m or
+ less.
User-created cable
8F User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 8G User-created cable must be 500m or
less.
GP-4107 (COM1)
GP-4*03T"S (COM2) The cable length
GP-4203T (COM1) 8H User-created cable must be 500m or
less.
GP4000"® (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) PFXZCBADTMI
SP5000™7 (COM1/2) 81 *10
SP-5B00 (COM2) +
ST6000*8 (COM2) User-created cable The cable length
ST-6200 (COM1) must be 500m or
STM6000 (COM1) less.
STC6000 (COM1)
ET6000™° (COM2) 8B User-created cable
PS6000 (Basic Box)
(COM1/2)
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CS/CJ Series HOST Link Driver

Displa
p. Y Cable Notes

(Connection Port)

4%
Ei—iegiidl\g éﬁng) RJ45 RS-485 Cable (5m) by Pro-face The cable length
(COMI) 8J PFXZLMCBRIJRS81 must be 500m or

less.

PE-4000B"!! I
PS5000"!! e cable leng
PS6000 (Optional 8K User-created cable must ble 500m or
Interface)*1 1 ess.

*1  All GP3000 models except AGP-3302B
*2  Except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)

m |[PC COM Port (page 10)
*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*7  Except SP-5B00
*8  Except ST-6200

*9  Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 8A.
*11  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
m |[PC COM Port (page 10)
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CS/CJ Series HOST Link Driver

8A)

¢ 1:1 connection

Display side
Terminal block Shield
rommmmmcceo “A
T inati R K AY
rf;?;gﬁ;g" Signal name ‘,' ,,'I ‘\ ExternaI‘ Device side
2200 RDA [« /\  Terminal block
! ]
Displa to inal
D CA3-ADPCOM-01 RDB At Sgnal name
[]:( — SDA / \; +——| SDB+
— 1 \ 1
I L SDB — — SDA-
\ \
CA3-ADPTRM-01 SG ‘\----------.‘._'I FG
FG
User-created cable
* 1:n connection
Display side
Terminal block
Termination | g Shield Shield
resistance. | S/9nal name /7TTTTTTTT External Device side T 7\ External Device side
2200 RDA 7 / \ Terminal block / { \ Terminal block
' lo 1 [
Displa ! ] : i [ .
play CA3-ADPCOM-01 RDB /\ :- E Signal name :. /\ .: :. Signal name
[D]/ — SDA / \:| : SDB+ fe—t / \ — SDB+
—_— ] ] ]
[\_ SDB —+ — SDA- |+ . SDA-
\ \
CA3-ADPTRM-01 | SG RN M—1 Fc LV, M| FG

FG

v

A

User-created cable
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CS/CJ Series HOST Link Driver

8B)
e 1:1 connection
Display side
D-sub 9 pin (socket) ,_“S_f:i_e_lg__m
Esrin;tigiggn Pin_| Signa name ,’/ ,'/ “\ External Device side
2200% 1 RDA [+ { '} Terminal block
Display 2 RDB :: li Signal name
3 SDA (— i—+—» SDA-
7 | soB j— / \"‘,‘: SDB+
5 SG N AV e
4 ERA
8 CSA :l
9 ERB
6 CSB :l
Shell FG
* 1:n connection
Display side
D-sub 9 pin (socket) ,_-__S.h_i?l.d___‘ .
Eégf;ﬁgzn Pin_| Sgnalname ,’/ ,'/ \\External Device side,""s'rll'elq,’\ External Device side
2200% 1 RDA ;' ::' ‘.: Terminal block ":' :/‘.“ Terminal block
Display 2 RDB ¢ /\é ; Signal name :.' /\ :: ‘E Signal name
3 SDA |— — SDA- fe—t — SDA-
7 | soB |— / \"‘ i spB+ |s "‘/ \'-,,." »| SDB+
5 | sG MNeeeee N | Fe L VAR s
4 ERA
8 CSA :l
9 ERB
6 CSB :l
Shell FG

GP-Pro EX Device/PLC Connection Manual 154



CS/CJ Series HOST Link Driver

8C)
¢ 1:1 connection
Display side
Terminal block
ot . Shield
::Srirzg:ggn Signal name ST External Device side
220Q RDA [+ H ‘\‘ Terminal block
] 1
Displa ! oy ol
P8 CA4-ADPONL-01 RDB Ad Signal name
— SDA :. " : SDA-
.= sDB | / \'\ ," SDB+
\ \ \
CA3-ADPTRM-01 |  SG 5 A FG
FG
User-created cable
¢ 1l:n connection
Display side
Terminal block
. . . Shield Shield
::;2;2?22” Signal name /' ---------- ,-"'\ External Device side/”~" """~ ’7\ , External Device side
2200 RDA 7 ',’ \‘ Terminal block ,:' ! ‘.‘ Terminal block
1 h \
Displa H P : | 1o .
P8 CA4-ADPONL-01 RDB = Py [Soename] i1 [Sonalname
— SDA — SDA- ; L SDA-
] ! / \! ! ' / \ i
.= SDB |— — SDB+ f+—+ — SDB+
\ \ \
CA3-ADPTRM-01 | sG L. v | Fc Moo FG
FG

F 3

v

User-created cable
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CS/CJ Series HOST Link Driver

8D)
e 1:1 connection
Display side
D-sub 9 pin (plug)
Termination| Pin | Signal name ,---§-h-|§|-d---,. L
resistance J /\ External Device side
2200 % 2 RDA ‘,‘ ! “. Terminal block
. ] 1
Display 7 RDB [ /\ :' ': Signal name
3 SDA 7 \', . SDA-
] ] ]
A 1 1
8 | sbB [+ r——]_SDB+
CA4-ADPONL-01 5 SG . »—— FG
Shell FG
User-created cable
e 1l:n connection
Display side
D-sub 9 pin (plug)
L . . Shield Shield
T t PO L ie
r:;gg:ggn Pin_| Signal name ; ,7‘\ External Device side/ """~~~ ’7\ \ External Device side
220Q % 2 RDA H / \ Terminal block { ¢\ Terminal block
] ]
Display 7 RDB :" =: Signal name :" /\ :' ": Signal name
]
3 | sba — SDA- fe—t - SDA-
MVANN L/ O\
8 | sDB - — SDB+ [+ — SDB+
\ \
CA4-ADPONL-01 [ 5 sG N eemeee A s K VAN e
Shell FG

v

A

User-created cable
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8E)
¢ 1:1 connection

Display

¢ 1:n connection

Display

CS/CJ Series HOST Link Driver

External Device side

i

Display side
Terminal block Shield Terminal block
FESSSSsssss ey
Termination | Signal name /I ," ‘\ Signal name
resistance :’ /\ F
2200 RDA | / \: H SDA-
\ \ H
CA3-ADPCOM-01 RDB 1= LA il
[]:( — SDA \ b FG
[ — SDB
CA3-ADPTRM-01 SG
FG
User-created cable
Display side ] External Device side ] External Device side
Terminal block __ffl.e_@__ Terminal block _.S.fllfld" Terminal block
Termination | Signal / 7\ ignal / A ignal
l mi . :e ignal name ", /\ ", \ Signal name / /\ i “- Signal name
2200 RDA : / \I SDA- / \ ¢ SDA-
1 ]
1 ] 1
CA3-ADPCOM-01 RDB | T SDB+ |+ | SPer
— SDA S, »—— FG Necooeee — FG
— SDB
CA3-ADPTRM-01 SG
FG

A

User-created cable
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CS/CJ Series HOST Link Driver

8F)
e 1:1 connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
Termination | Pin | Signal name ,’I’“““-“:’?\\ Signal name
resistance H /\ [
220Q 1 DATA+ [« : —> SDA-
Display % 2 | DATA- ‘:\ / \:‘ I." » SDB+
N
3 NC N 4 FG
7 NC
5 |SG(GND)
4 ERA
8 CSA :l
9 ERB
6 CSB :l
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) ’__ftﬂ_e_lf‘__ Terminal block ,-.S.rli?'.d.-, Terminal block
;I'er_m‘ina:(t‘isn Pin [ Signal name 'l,’l /\ :,’7\‘\" Signal name ",'l /\ :," ‘\‘. Signal name
2200 1 | DATA+ [« — SDA- : — SDA-
Display % DATA- ‘\ / \:‘ I." SDB+ “/ \“ f SDB+
N \ !
NC N ‘e’ FG Neeeeeee o— FG
NC
SG(GND)

ERA

CSA :l
ERB

6 CsSB :l

Shell FG

Olo|h|lO|IN|[W]DN

GP-Pro EX Device/PLC Connection Manual 158



CS/CJ Series HOST Link Driver

8G)
¢ 1:1 connection
Display side External Device side
Terminal block ‘___S_f_Ti_e_lfi__’ Terminal block
Termination | Signal name l,'l / \‘\ Signal name
resistance *1 RDA :: /\ :' ‘,ll SDA-
Display RDB |« / \f i— sDB+
spA b4 FG
SDB —— N/
SG
ERA
CSA :l
ERB
CSB :l
e 1l:n connection
Display side External Device side External Device side
Terminal block ‘__ff_ﬂ_e_lfi__ Terminal block ~_ Shield - Terminal block
Termination Signal name l,'l /\ '," \\‘ Signal name ','l /\ '," ‘\‘ Signal name
reS|stance*1lé_ RDA :' / \:l ". SDA- :/ \: ; SDA-
Display RDB |« ; ; SDB+ “ “ / SDB+
SDA |+ L +—] Fo S w—1 FfG
SDB —— ___\/
SG
ERA
CSA :l
ERB
CSB :l

*
1 rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 ON

The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
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8H)

¢ 1:1 connection

Display side External Device side
D-sub 9 pin (socket) ’__ftﬂ_ﬁi'fi__ Terminal block
rT:Srinswtigstci(e)n Pin | Signal name 'l,’l /\ :,’7\““' Signal name
2200 3 | LINE+ |e i———{ SDA-
Display 8 LINE- ‘:\ / \:\ ,': » SDB+
5 |sG@GND)| o’ FG
1 NC
2 NC
4 |RS(RTS)
6 5V
7 NC
9 NC
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) ’__ftﬂ_e_lf‘__ Terminal block ,-.S.h.i?lq-,. Terminal block
::;gti;sgg Pin | Signal name 'l,’l /\ :,’7\‘\‘ Signal name ','l /\ '," ‘\‘. Signal name
220 3 | LINE+ [ / \: ‘: SDA- ;/ \; : SDA-
Display 8 | LINE- ‘\ ‘.\ /: SDB+ '.\ ',\ ;' SDB+
5 [SG(GND)| ‘e’ FG Ncceoeee o— FG
1 NC
2 NC
4 [RS(RTS)
6 5V
7 NC
9 NC
Shell FG
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|

81)

¢ 1:1 connection

Display side
Terminal block
- ; Shield
Termination | Sgralnae | - =====2"=x, 'External Device side
2200 RDA [« { \  Terminal block
. ! !
Display RDB ': /\:' =. Signal name
1 )
— SDA [ 7 \:. —{ SDA-
— ] ]
[\_ SDB |+ — SDB+
\ N
PFXZCBADTM1 SG \ ‘\_-’ FG
FG
User-created cable
¢ 1l:n connection
Display side
Terminal block
P ' Shield Shield
Termination | Signal name iy 7+ External Device side /~~~""""" 7 External Device side
resistance / o\ ; / \ .
RDA 7 ! '\ Terminal block ¢ v Terminal block
2200 ! oA .' .
Display RDB ¢ ': ;' ': Signal name :‘ i ': Signal name
___ SDA [— Ad SDA- [e—it A - SDA-
\ v \ v
.= SDB / \ +—( SDB+ ¢ ‘.‘/ \‘, +—>| SDB+
\ N\ \ v
PFXZCBADTM1| SG \ A, FG [ VAR B e
FG

User-created cable
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|

81)

1:1 connection

External Device side
Terminal block

Display Signal name
D1 SDA-
DO SDB+
(1) GND FG
¢ 1:n connection
External Device side . External Device side
Terminal block __S_fllfld__ Terminal block
Display Signal name ’," /\ ','I ‘\‘ Signal name
DA SDA- [«—+ 7\ ——{ SDA-
1 1 )
DO SDB+ T —7 SDB+
1) GND FG AN W1 Fe
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRIJRS1
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8K)
e 1:1 connection
Display side _ External Device side
D-sub 9 pin (socket) Shield Terminal block
Termination| pin | Signalname |/ ,’?\\ Signal name
resistance H /\ Do
' 2200% 2 DATA+ ‘i / \: T SDA-
Display 1 | DATA- (= — SDB+
\ A} 1
3 NC N e FG
7 NC
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
e 1l:n connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
e ——————— - ym——————— A,
Termination ; ! / N ) / N\ -
resistance Pin [ Signal name ,/ /\ :,’ \‘ Signal name ',' /\ "l\‘. Signal name
N ] 1 1
| 2200% 2 DATA+ ! / \: i SDA- : - SDA-
Display 1 DATA- fe— T +—> SDB+ <—‘—/" \—\—-—>" H SDB+
\ \ 1
3 NC \ ‘o’ FG Meeee w1 Fe
7 NC
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
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Cable Diagram 9

CS/CJ Series HOST Link Driver

Display
(Connection Port)

Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000"2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IpC"3

PC/AT

9A

User-created cable

The cable length must
be 15m or less.

GP-4105 (COM1)
GP-4115T (COMI)
GP-4115T3 (COMI)

9B

User-created cable

The cable length must
be 15m or less.

LT-4*01TM (COM1)
LT-Rear Module
(COM1)

9C

RJ45 RS-

232C Cable (5m) by Pro-face
PFXZLMCBRIJR21

The cable length must
be 5m or less.

*1
*2  Except SP-5B00
*3

H |PC COM Port (page 10)

9A)

Display

Display side

All GP4000 models except GP-4100 series and GP-4203T

Only the COM port which can communicate by RS-232C can be used.

External Device side

D-sub 9 pin (socket)

Pin

Signal name

Terminal block

Shield

RD(RXD

Pin

Signal name

SD(TXD)

1

SD(TXD)

SG

RD(RXD)

RS(RTS)

O IN|JOjw|DN

RS(RTS)

CS(CTS)

CS(CTS)

SG

ol lw N

FG
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9B)
Display side External Device side
Terminal block Terminal block
Signal name Shield Pin Signal name
Display RD(RXD )\« . ,," kY 1 SD(TXD)
SD(TXD) 2 | RD(RXD)
SG .: 3 RS(RTS)
RS(RTS) : 4 | cs(cTs)
CS(CTS) 5 SG
6 FG
90)
External Device side
Terminal block
Pin | Signal name
Display RXD
1 SD(TXD)
XD 2 | RD(RXD)
(1) I_: 3 RS(RTS)
GND 4 CS(CTS)
5 SG
6 FG
Legend Name Note
RJ45 RS-232C Cable (5m) by Pro-face
(1) PFXZLMCBRIJR21
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CS/CJ Series HOST Link Driver

Display

I
(Connection Port) Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000"2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1) 10A User-created cable
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IpC"3

PC/AT

The cable length must
be 15m or less.

GP-4105 (COM1)
GP-4115T (COMI)

GP-4115T3 (COM1) 10B User-created cable

The cable length must
be 15m or less.

LT-4*01TM (COM1)
LT-Rear Module
(COM1)

RJ45 RS-232C Cable (5m) by Pro-face
10C PFXZLMCBRJR21

The cable length must
be 5m or less.

*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Except SP-5B00

*3  Only the COM port which can communicate by RS-232C can be used.
H |PC COM Port (page 10)

10A)

Display side External Device side

D-sub 9 pin (socket) Terminal block
Pin | Signal name I,§P.i?|.(;\ Pin | Signal name
Display 2 RD(RXD)i« l'l ,"I “‘ 1 SD(TXD)
3 | SD(TXD)}—— L, 2 | RoRxD)

5 SG ! 3 SG

7 |RS(RTS) AN A FG
8 CS(CTS) :I 5 SD(TXD)
6 RD(RXD)

7 SG

8 FG
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|

10B)
Display side External Device side
Terminal block Terminal block
Signal name ',§[‘.i?|.?,\ Pin Signal name
Display | RD(RXD)——i—i—% 1 | soxo)
SD(TXD) :' :' l: < RD(RXD)
SG I".\ Il‘.‘ ,,': 3 SG
RS(RTS) N 4 FG
CS(CTS) :—l 5 SD(TXD)
6 RD(RXD)
7 SG
8 FG
10C)
External Device side
Terminal block
. Pin | Signal name
Diepiay RXD 1| sD(TXD)
TXD 2 | RD(RXD)
(1M S 3 SG
4 FG
5 SD(TXD)
6 RD(RXD)
7 SG
8 FG
Legend Name Note
RJ45 RS-232C Cable (5m) by Pro-face
1) PFXZLMCBRIR21
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6 Supported Device
Range of supported device address is shown in the table below. Please note that the actually supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.
6.1 CS1/CJ1 Series
[==—— This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Channel I/0 0000.00-6143.15 0000-6143
Internal Auxiliary Relay W000.00-W511.15 W000-W511
Special Auxiliary Relay A000.00-A959.15 A000-A959 *l
Latch Relay HO000.00-H511.15 HO000-H511
Timer T0000-T4095 - *2

(Time Up Flag)

Counter

= - *2
(Count Up Flag) C0000-C4095
Timer (Current Value) - T0000-T4095
Counter (Current Value) - C0000-C4095
Data Memory D00000.00-D32767.15 D00000-D32767 LIH "3
Extension Data Memory E000000.00- *4%5
(E0-EC) EC32767.15 E000000-EC32767
Extension Data Memory 9]
(Current Bank) - EMO00000-EM32767 *5%6
Task Flag *2
(Bit) TKB00-TKB31 -
=2
Task Flag TK00.00-TK31.07 TKO00-TK30 =<1
(Status)
= 3]
Index Register - IR00-IR15 !57__1
Rk
Data Register - DRO0-DR15 LT—]
*1  Write disable in A00O to A447.
*2  Write disable
*3  When using the communication unit (CS1W-SCU21), do not use the address of D30000 to D31599. When using
the communication board (CS1W-SCU21/41), do not use the address of D32000 to D32767. These addresses
may be used as the system setting area on the External Device.
*4  Max 13 banks (EO to EC) can be used. 1 bank can contain 32768 words. Available bank number is different
depending on the CPU unit.
*5  CJM1 Series does not include the extension data memory (EO to EC, current bank EM).
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*6  CJI1 Series does not include the extension data memory (current bank EM).

*7  You cannot write during RUN.

NOTE | * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
 Please refer to the precautions on manual notation for icons in the table.

@:Supported Devices Symbol and Terms
 Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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CS/CJ Series HOST Link Driver

6.2 CJ2 Series
[=— This address can be specified as system data area.
Device Bit Address Word Address :|tzs Notes
Channel I/0 0000.00 - 6143.15 0000 - 6143 "
Internal Auxiliary Relay W000.00 - W511.15 WO000 - W511
Special Auxiliary Relay A0000.00 - A1471.15 A0000 - A1471 *)
A10000.00 - A11535.15 A10000 - A11535
Latch Relay H000.00 - H511.15 H000 - H511 "3
Timer (Time Up Flag) T0000 - T4095 - 4
Counter (Count Up Flag) C0000 - C4095 - 4
Timer (Current Value) - T0000 - T4095
Counter (Current Value) - C0000 - C4095
Data Memory D00000.00 - D32767.15 D00000 - D32767 I—Lﬂ] *
Fé‘é‘fgjg’)” Data Memory E(l)goggggf? X E0 00000 - E18 32767 *5%6
Féﬁfp:::g::g Memory - EMO00000 - EM32767 E9)
T(%sl‘tk) Flag TKB000 - TKB127 - .
Task Flag TK000.00 - TK127.07 TK000 - TK126 =2+
(Status)
Index Register - IR00 - IR15 el 7
Data Register - DROO - DR15 b 77

*1

*2
*3

*4
*5

*6

*7

Do not write in Channel I/O address 1500-1899 and Data Memory address D30000-D31599 from the Display.
Because those address are used for setting the system on the External Device.

Write disable in AO0OO - A447 and A10000 - A11535.

When the CPU is CJ2H-CPU64-EIP, the bit address range is H000.00 to H999.15 and the word address range
is HO00 to H999.

Write disable

When the CPU is CJ2H-CPUG64-EIP, the device is the extension data memory (E0-E3), the bit address range
is E0 00000.00 to E3 32767.15, and the word address range is EO 00000 to E3 32767.

Max 24 bank (EO to E18) can be used. 1 bank is 32768 words. Available bank number is different depending
on the CPU unit.

Write disable during RUN
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NOTE | ¢ Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

@:Supported Devices Symbol and Terms
* Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.3 CP1 Series
[=— This address can be specified as system data area.
. . 32bit

Device Bit Address Word Address s Notes
Channel I/0 0000.00-6143.15 0000-6143
Internal Auxiliary Relay W000.00-W511.15 WO000-W511
Special Auxiliary Relay A000.00-A959.15 A000-A959 *l
Latch Relay H000.00-H511.15 HO000-H511 "2
Timer T0000-T4095 ; *3
(Time Up Flag)
Counter 3
(Count Up Flag) C0000-C4095 -
Timer (Current Value) - T0000-T4095 L/H
Counter (Current Value) - C0000-C4095
Data Memory D00000.00-D32767.15 D00000-D32767
Task Flag *3
(Bit) TKBO00-TKB31 -
Task Flag *3
(Status) TKO00.00-TK31.07 TKO00-TK30 =2 |
Index Register - IR00-IR15 .l ™
Data Register - DRO0-DR15 e T

*1  Write disable in A000 to A447.
*2  When the CPU is CP1H-X40DR-A, the bit address range is H000.00 to H999.15 and the word address range

is HO00 to H999.
*3  Write disable

*4

You cannot write during RUN.

NOTE | * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
 Please refer to the precautions on manual notation for icons in the table.

@:Supported Devices Symbol and Terms
 Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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CS/CJ Series HOST Link Driver

6.4 CP1E Series
[=— This address can be specified as system data area.
. , 32bit
Device Bit Address Word Address s Notes

Channel I/0 000.00-289.15 000-289
Internal Auxiliary Relay W00.00-W99.15 WO00-W99
Special Auxiliary Relay A000.00-A753.15 A000-A753 *l
Latch Relay HO00.00-H49.15 H00-H49
Timer )
(Time Up Flag) T000-T255 - LIH)
Counter 3
(Count Up Flag) €000-C255 )
Timer (Current Value) - T000-T255
Counter (Current Value) - C000-C255
Data Memory D0000.00-D8191.15 D0000-D8191

*1  Write disable in A000 to A447.
*2  Write disable

NOTE | * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

@DSupported Devices Symbol and Terms
* Please refer to the precautions on manual notation for icons in the table.

& "Manual Symbols and Terminology"
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6.5 CP2E Series
[=— This address can be specified as system data area.
. . 32bit

Device Bit Address Word Address s Notes
Channel I/0 000.00-289.15 000-289
Internal Auxiliary Relay W000.00-W127.15 WO000-W127
Special Auxiliary Relay A000.00-A959.15 A000-A959 *l
Latch Relay H000.00-H127.15 HO000-H127
Timer )
(Time Up Flag) T000-T255 )
Counter LIH |
(Count Up Flag) €000-C255 )
Timer (Current Value) - T000-T255
Counter (Current Value) - C000-C255
Data Memory D00000.00-D16383.15 D00000-D16383
Index Register - IR00-IR15 a3
Data Register - DRO0-DR15 e KT

*]1  Write disable in A000 to A447.
*2  Write disable

*3  You cannot write during RUN.

NOTE | * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

@DSupported Devices Symbol and Terms
* Please refer to the precautions on manual notation for icons in the table.

& "Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device code and address code when you select "Device & Address" for the address type in data displays.

Device Device Name Device Code (HEX) Address Code
Channel I/0 - 0080 Word Address
Internal Auxiliary Relay W 0082 Word Address
Special Aucxiliary Relay A 0085 Word Address
Latch Relay H 0084 Word Address
Timer (Current Value) T 0060 Word Address
Counter (Current Value) C 0061 Word Address
Data Memory D 0000 Word Address
EO 0010 Word Address
El 0011 Word Address
E2 0012 Word Address
E3 0013 Word Address
E4 0014 Word Address
E5 0015 Word Address
E6 0016 Word Address
E7 0017 Word Address
E8 0018 Word Address
E9 0019 Word Address
:Eé(é?gig))n Data Memory EA 001A Word Address
EB 001B Word Address
EC 001C Word Address
ED 001D Word Address
EE 001E Word Address
EF 001F Word Address
E10 0020 Word Address
Ell 0021 Word Address
E12 0022 Word Address
E13 0023 Word Address
El4 0024 Word Address

o
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Device Device Name Device Code (HEX) Address Code

E15 0025 Word Address

Extension Data Memory E16 0026 Word Address

(EO-E18) E17 0027 Word Address
E18 0028 Word Address

Extension Data Memory EM 0001 Word Address

(Current Bank)

Task Flag TK 0002 Word Address

(Status)

Index Register IR 0003 Word Address

Data Register DR 0004 Word Address
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem

Description

No.

Error No.

Device Name

Name of External Device where error occurs. Name of External Device is a title of
External Device set with GP-Pro EX. (Initial value [PLC1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

» IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
» Device address is diplayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAAOQ36: PLC1: Error has been responded for device read command (Error Code: 4355[1103h]

There are out of range devises)"

NOTE | * Device specific error codes (2 bytes) are structured as "Main Response Code (1 byte)" and "Sub
Response Code (1 bytes)". If the Main Response Code is 0x11 and the Sub Response Code is 0x03,

then the received error code is 0x1103.

» Refer to your External Device manual for details on received error codes.

« Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error

messages common to the driver.

B Error Code Peculiar to External Device

Device specific error codes (2 bytes) are displayed as "Main Response Code (1 byte)" and "Sub Response Code (1

bytes)".

When received the error code from the external device, add to the below message. "Main Response Code" is dis-

played continuously "Main Response" and "Sub Response Code" is displayed continuously "Sub Response".

For details of the error code, please refer to the manual of the external device.

The error code peculiar to the external device is as follows.

Message ID Error Message Description
(Node Name): Error has been responded for device read command Display the error message,
RHxx130 (Main Response: [Hex], Sub Response: [Hex]) when the error occurred by
esponse: [Hex], Sub Response: the reading demand.
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Message ID Error Message Description
(Node Name): Error has been responded for device write command Display the error message,
RHxx131 . when the error occurred by
(Main Response: [Hex], Sub Response: [Hex]) .
the write demand.
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